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Abstract:

Biochemical methods can reveal stable protein-protein interactions 
occurring within cells, but the ability to observe transient events and to 
visualize the subcellular localization of protein-protein interactions in 
cells and tissues in situ provides important additional information. 
Proximity Ligation Assay® (PLA) offers the opportunity to visualize the 
subcellular location of such interactions at endogenous protein levels, 
provided that the probes that recognize the target proteins are within 
40nm. This sensitive technique not only elucidates protein-protein 
interactions, but can also reveal post-translational protein modifications. 
This technique is useful even in cases where material is limited, such as 
when paraffin embedded clinical samples are the only available material, 
as well as after experimental intervention in 2D and 3D model systems. 
Here we detail the basic protocol for the commercially available 
Proximity Ligation Assay™ materials (Sigma-Aldrich, St. Louis, MO) and 
have incorporated details to aid the researcher in successfully performing 
the experiments.
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Significance Statement

The Proximity Ligation Assay is a versatile method useful for a variety of applications in the cell biology 
laboratory. This method is suitable for visualizing post-translational protein modifications, protein-
protein interactions, and amplifying signals to detect proteins and protein-protein interactions that are 
at low levels in cells and tissues while eliminating high background signals that may be associated with 
traditional immunofluorescence. The technique allows the investigator to determine the subcellular 
location of such events that are either transient or stable, and it can be used to visualize both ectopically 
expressed proteins as well as endogenous proteins. This is particularly useful in situations where genetic 
manipulation is not favorable or possible, such as when analyzing clinical samples. 

Abstract

Biochemical methods can reveal stable protein-protein interactions occurring within cells, but the ability 
to observe transient events and to visualize the subcellular localization of protein-protein interactions in 
cells and tissues in situ provides important additional information. Proximity Ligation Assay® (PLA) offers 
the opportunity to visualize the subcellular location of such interactions at endogenous protein levels, 
provided that the probes that recognize the target proteins are within 40nm. This sensitive technique 
not only elucidates protein-protein interactions, but can also reveal post-translational protein 
modifications. This technique is useful even in cases where material is limited, such as when paraffin-
embedded clinical specimens are the only available material, as well as after experimental intervention 
in 2D and 3D model systems. Here we detail the basic protocol for the commercially available Proximity 
Ligation Assay™ materials (Sigma-Aldrich, St. Louis, MO) and have incorporated details to aid the 
researcher in successfully performing the experiments.

Basic Protocol #1: Proximity Ligation Assay

Basic Protocol #2: Imaging, quantification and analysis of PLA signals

Support Protocol #1: Antigen retrieval method for formalin fixed paraffin-embedded tissues

Support Protocol #2:  Creating custom PLA probes using the Duolink™ In Situ Probemaker Kit when 
commercially available probes are not suitable

Keywords:

Proximity ligation assay®

Protein-protein interaction

Post-translational modification

In situ tissue staining

Duolink™
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Introduction:

This unit describes the powerful and sensitive technique of the Duolink™ Proximity Ligation Analysis® 
(PLA). This method provides an advantage over traditional immunofluorescence co-localization and 
biochemical immunoprecipitation methods in that the analysis of individual proteins, protein-protein 
interactions, or specific protein modifications is paired with the ability to observe the subcellular 
localization of the occurrence. Biochemical precipitation methods are suitable to detect stable 
interactions between proteins, but detection of more transient interactions may be overlooked and may 
be impossible in cases where material is limiting, such as when working with patient material. 
Subcellular localization can be obtained with other biotechnological fluorescence methods such as 
biomolecular fluorescence complementation, fluorescence resonance energy transfer (FRET), or 
optogenetics; however, these methods require the expression of ectopically expressed proteins, and 
design of the protein constructs can be fraught with difficulties (Sam Duwé & Dedecker, 2019). PLA 
offers the opportunity to visualize the subcellular location of endogenous protein interactions or 
modifications that are either transient or stable without the need of ectopically expressed proteins. This 
is particularly useful in situations where genetic manipulation is impossible or not favorable, such as 
when analyzing paraffin-embedded or frozen tissue sections. Utilizing investigator selected antibody 
pairs for detection of antigens, PLA can complement immunofluorescence assays as a sensitive method 
for detection and quantification while reducing the background and non-specific staining that may be 
observed using traditional immunofluorescence methods.

The PLA technique uses Duolink™ technology in which probes bind to the constant regions of primary 
antibodies. The probes are ligated together, hybridizing to form a circular DNA. Fluorescent- or HRP-
labeled oligonucleotides are then incorporated during the process of rolling circle amplification. This 
incorporation during amplification produces a fluorescent “spot” that can be visualized in cells and 
tissues by microscopy and quantified (Figure 1). This article outlines the procedure for Duolink™ 
fluorescent reagents and how to image, quantify and analyze PLA signals. Two support protocols 
describe the antigen retrieval method for formalin fixed paraffin-embedded tissues and creating custom 
PLA probes using the Duolink™ In Situ Probemaker Kit.

Strategic Planning:

Before embarking on a PLA experiment, the investigator must vet the antibodies to be used for the 
assay using a traditional immunofluorescence assay. Initially, the conditions for the antibodies should be 
optimized to determine the best fixation/permeabilization (e.g. methanol or paraformaldehyde followed 
by detergent permeabilization) and dilution for each antibody (Donaldson, 2015). Although there are 
solutions provided in the PLA kit, the investigator is encouraged to use custom blocking buffers and 
antibody diluents that work best for the desired immunofluorescence conditions.  A recipe for a solution 
that works well as both a blocking agent and antibody diluent is included in this unit.  The antibodies 
should be titrated to determine a dilution for each that maximizes recognition of the protein, while 
decreasing the amount of background observed during traditional wide-field immunofluorescence 
imaging. Furthermore, high titer of antibody can cause the distinct fluorescent spots to merge together, 
which limits quantification.  In general, the antibody pairs need to consist of antibodies from two 
different species, and there are a select number of species available when using the commercially 
available kit (mouse, rabbit, goat or human). When the same species must be used, or if a species is not 
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part of the select number available, there is a custom probe making kit that can be purchased and these 
custom probes can be combined with the commercially available probes (refer to Support Protocol #2 
below).  

Traditional immunofluorescence staining with the antibodies of the PLA pair should be included in 
parallel with the proximity ligation assay as a control to demonstrate effective binding by the primary 
antibodies in each experiment. Refer to protocols by Donaldson and Hoffman and Taylor for 
immunostaining of cells and immunohistochemistry of tissues (Donaldson, 2015; Hofman & Taylor, 
2013). Determination of successful immunofluorescence staining can be completed and confirmed before 
moving forward with the rest of PLA protocol. Controls to demonstrate specificity of the PLA reaction are 
necessary in each experiment. An example of this would be the absence of the protein as the most 
stringent and appropriate negative control. This can be accomplished by siRNA or shRNA silencing of 
proteins, or utilizing cells that lack expression of the protein(s) of interest, such as cells or tissue from 
knock out animal models. Another control that may be included is using only one primary antibody in 
the reaction to provide information about non-specific antibody binding. While not ideal, pre-immune 
serum or a non-specific IgG may be paired with the antigen specific antibody. Alternatively, an antibody 
recognizing a non-interacting protein can be paired with the antibody recognizing the protein(s) of 
interest as a negative control. A positive control should also be included in the form of antibodies that 
recognize two proteins known to interact in the cells or tissues of interest. Two antibodies that 
recognize different epitopes of the same protein may be used, as well.  Sigma Aldrich also offers a PLA 
control kit consisting of mouse anti-EGFR antibody and rabbit anti-ErbB2/HER2 antibody 
(https://www.sigmaaldrich.com/catalog/product/sigma/duo92202).

Basic Protocol #1: Proximity Ligation Assay

Materials

 Cells of interest grown on coverslips (Ted Pella 15 mm no. 1 round coverslips, cat. no. 
26024 placed in 12-well culture dishes or Ted Pella 12 mm no. 1 round coverslips cat. 
no. 26023 placed in 24-well culture dishes are recommended to save on reagent), frozen 
sections from tissue specimens, or paraffin-embedded, antigen retrieved tissue sections 
on glass slides.

 Fixative of choice for 2D culture monolayers or frozen sections. Typically, 4% 
paraformaldehyde (commercially available ampules diluted to 4% using phosphate 
buffered saline (e.g. Thermo Scientific cat. no. 28908), or refer to recipe included in this 
unit).

 Detergent permeabilization buffer for recognition of cytoplasmic epitopes (if using 
paraformaldehyde for fixation (refer to recipe included in this unit, usually 0.1-0.5% 
Triton X-100.

 Primary antibodies from 2 different species and of the IgG-class (available species: 
mouse, rabbit, goat or human) or refer to Support Protocol #2 regarding making custom 
probes if the available species are not compatible with your antibody reagents.
Antibodies used in this manuscript: HECD-1 mouse anti-Ecadherin (Thermo Fisher 
Scientific, cat. no 13-1700, RRID AB_2533003), C2206 rabbit anti-β-catenin (Sigma-
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Aldrich cat. no. C2206, RRID:AB_476831), 1407 chicken anti-Plakoglobin (Aves 
Laboratories), anti-EGFR D38B1 (Cell Signaling Technology cat. no. 4267, 
RRID:AB_2246311), mouse anti-Nedd8 (Sigma-Aldrich cat. no. N2786, RRID:AB_260757), 
AB-12 mouse anti-EGFR (NeoMarkers, cat. no. MS-400-P1), FK2 mouse anti-Ubiquitin 
(Millipore cat. no. 04-263, RRID:AB_612093), goat anti-Dsg1 (R and D Systems cat.no. 
AF944, RRID:AB_2277393), 11E4 mouse anti-Plakoglobin (Millipore cat. no. MAB2083, 
RRID:AB_2127995).

 Kimwipes®  or Whatman® #1 filter paper or equivalent filter paper (e.g. Fisher Scientific 
P5 Filter paper cat. no 09-802-1A) (rip the filter paper so there is a jagged edge for 
wicking away solutions).

 Wash buffer suitable for traditional immunofluorescence using the antibody pairs 
chosen, typically phosphate buffered saline (PBS) (commercially purchased or made 
with molecular grade water, refer to recipe in this unit).

 Duolink™ In Situ Fluorescence Kit (Sigma-Aldrich, St. Louis, MO): 

Refer to the Sigma-Aldrich catalog for catalog numbers 
https://www.sigmaaldrich.com/catalog/product/sigma/duo92202

 PLA® probe MINUS, recognizing one of the antibody species in the pair 
(includes Blocking Solution and Antibody Diluent). Store at 4°C.

 PLA® probe PLUS, recognizing the 2nd antibody species of the pair 
(includes Blocking Solution and Antibody Diluent). Store at 4°C

 Optional: Custom probe(s) can be generated using the Duolink™ In Situ 
Probemaker Kit and may be used in coordination with commercial 
probes (refer to Support Protocol #2 in this unit).

 Wash Buffers A and B (powders for reconstitution available for 
purchase, or made from the recipe provided in this unit). Store 
reconstituted buffers at 4°C.

 Ligation 5× buffer (contains oligonucleotides that hybridize to the PLA® 
probes). Store at -20°C.

 Ligase 1U/µl. Store at -20°C. Keep in a freeze block when not at -20°C.
 Amplification 5× Buffer (contains components for rolling circle 

amplification and oligonucleotide probes labeled with fluorophore of 
choice that hybridizes to the amplified product). Store at -20°C in the 
dark. Keep in freeze block when not at -20°C.
  4 fluorophore options: Green (λEx 490 nm/ λEm 520 nm; FITC 

filter), Orange (λEx 542 nm/ λEm 562 nm; Cy3™ filter), Red (λEx 
593 nm/ λEm 622 nm; Texas Red® filter) or Far Red(λEx 646 nm/ 
λEm 664 nm; Cy5™ filter).

 Polymerase 10 U/µl. Store at -20°C in the dark. Keep in freeze block 
when not at -20°C.

 Duolink™ In Situ Mounting Medium with DAPI (4′,6-diamidino-2-phenylindole, nuclear 
stain) (Sigma cat. no. DUO82040). The Duolink™ mounting media does not solidify. One 
can use their own mounting media. If the mounting media does not contain DAPI incubate 
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6

the coverslips or slides with DAPI before the final Wash Buffer B washes at the end of the 
basic protocol (see below).

 Optional: DAPI (4′,6-diamidino-2-phenylindole) stock solution: 10 mg/ml in high purity 
water. Dilute the stock 1:5,000 in PBS for application to cells and tissues. This is not 
necessary if using the DAPI-containing mounting media supplied with the Duolink™ kit 
(see above).

 Optional: Mounting media. If one prefers to use mounting media that solidifies, there 
are a number of commercial sources that may or may not include DAPI (e.g. 
Vectashield® (Vector Laboratories cat. no. H-1500-10) or Prolong® Gold (Invitrogen cat. 
no. P36930). Sigma Aldrich warns that the PLA signal may fade more quickly when using 
different mounting media other than the Duolink In Situ Mounting Media. 

 Optional: nail polish can be used to seal the edges of the coverslip to avoid movement 
of the samples when storing, or when imaging with an immersion objective. Glitter nail 
polish adheres well to the coverglass to make a seal. Make certain the nail polish is 
hardened before imaging to avoid transfer of polish to the objective. 

Equipment

 Staining materials such as
o Hot plate (e.g. Fisher Scientific) for heating 0.1 M Citrate buffer for antigen retrieval of 

paraffin-embedded tissues (Refer to Support Protocol #1 for steps on antigen retrieval)
o Thermometer for monitoring citrate buffer and paraformaldehyde solutions
o Humidified chamber for slides or coverslips 

 Homemade humidity chambers can be made using a plastic container with a lid, 
such as a 150 mm petri dish (e.g. Sigma cat. no. P7737). Whatman® #1 filter 
paper (or equivalent filter paper) is cut to fit in the bottom of the container, wet 
with water, and overlaid with strips of parafilm. Coverslips are then placed on 
the parafilm cell side up for short term incubations or cell-side down 
sandwiching solutions between the coverslip and the parafilm for 
overnight/long term incubations.  The container or dish is sealed with parafilm 
to maintain moisture in the chamber during the incubations. For tissue slides, 
pieces of 2 ml plastic pipettes can be taped into the container or dish to lift 
slides from the floor of the chamber. In this case, water can be placed directly 
on the bottom of the dish, and filter paper is not needed. We recommend 
flipping the dish and using the lid of the container as the base, and the base of 
the container as the lid. This will provide more room for the slides when sitting 
on top of the taped plastic pipettes.

 Humidity incubation chambers for slides are available for purchase from 
multiple vendors (e.g. Sigma Aldrich, Fisher Scientific, VWR). 

o Grease pen (e.g. white one Sharpie brand, manufacturer # BERCM164T ) or PAP Pen to 
create a hydrophobic barrier around sections (e.g. ImmEdge® Hydrophobic Barrier PAP 
Pen (Vector Laboratories cat. no. H-4000), Super PAP Pen (Invitrogen cat. no. 008899) or 
ReadyProbes™ Hydrophobic Barrier Pap Pen (Invitrogen cat. no. R37622). Use caution 
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7

with pap pens, as they may interfere with the PLA reaction, or visualization of PLA signal 
when detergent in included in primary antibody diluents and/or PLA probe solutions (see 
Troubleshooting).

o Freezing block for enzymes (e.g. Thermo Scientific, cat. no. 5115-0032).
o High purity water (Millipore Milli-Q® lab water system or molecular grade water).

Protocol Steps

Do not let the coverslips or tissue sections dry out at any point during the procedure, until after the final 
wash with 0.01× Wash buffer B, directly prior to mounting to avoid background from non-specific 
reagent deposition. Use high purity/molecular grade water to prepare all solutions.  All solutions should 
be at room temperature before adding them to your coverslips or slides and all washing steps are done 
at room temperature.

Primary Antibody Incubation:

1. Fix cell monolayers or frozen tissue sections using the method that preserves antibody 
recognition of antigens of interest. Process paraffin-embedded tissues for antigen retrieval 
(refer to Support Protocol #1 for the antigen retrieval procedure).

2. Permeabilize cell monolayers, or tissue sections, as performed for traditional 
immunofluorescence. Typically, a 10 minute, room temperature incubation of cell monolayers 
with 0.2% Triton X-100 in PBS is sufficient. The blocking buffer recipe included in this unit also 
contains 1% Bovine Serum Albumin and can be used for this permeabilization step, the following 
blocking step (step 3) and as an antibody diluent (step 4). 

A grease pen or a pap pen may be used to create a hydrophobic boundary around tissue sections 
to decrease the amount of reagent used, however do not create the boundary until after this 
permeabilization step. Pap pens may be incompatible with detergents, such as Triton X-100. 
Inclusion of detergents in solutions following pap pen use may negatively affect the PLA reaction 
(e.g. hazy background, non-specific PLA signal, or reduced PLA signal). Custom blocking buffer 
without detergent, or the blocking buffer included in the PLA probe kit may be used in step 3 
below. The antibody diluent in the PLA probe kit may be used to dilute antibodies (step 4, below) 
and PLA probes (step 8, below) when using a pap pen.
 

3. Block non-specific antibody binding by increasing the time of the permeabilization incubation in 
the previous step from 10 minutes to 30 minutes at room temperature.  Alternatively, the 
blocking buffer supplied in the PLA probe kit may be used by adding it dropwise to the coverslip 
or slide.
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4. Dilute your primary antibody pairs to the appropriate dilution in the permeabilization/block 
buffer used in the previous steps 2 and 3, or use the antibody diluent supplied with the PLA 
probe kit. The amount added to each coverslip/tissue section depends on the dimension of the 
sample. 40 µl of each solution is sufficient to cover the surface of a 15 mm coverslip.

A primary antibody that is a different species than those antibodies that are used for the PLA 
reaction may be included for counterstaining, for example to indicate cell boundaries, or to 
highlight a subcellular compartment to apply spatial significance to the PLA signal. Add the 
primary antibody for counterstaining with the antibodies being used in the PLA reaction.

5. Tap off the blocking buffer by touching the edge of the coverslip or slide against a piece of filter 
paper or a Kimwipe® and replace it with the diluted antibodies. Keep the amount of residual 
blocking buffer left on the sample and the amount of primary antibody added the same among 
the coverslips or slides to maintain consistency among samples. 

6. Incubate the coverslips or slides with primary antibody in a humid chamber sealed with parafilm 
using temperatures and times that are optimal for the antibody pairs, such as 1-2 hours at 37°C, 
or overnight at 4°C. 

The PLA procedure contains multiple extended incubation steps. Allowing the primary antibodies 
to bind overnight at 4°C is a convenient step at which to pause the protocol. For overnight 
incubation, add the antibody on the coverslip and flip it over with the solution cell-side down on 
to the parafilm, sandwiching the antibody between the coverslip and the parafilm to ensure that 
the samples do not dry out during the extended incubation time. In the case of tissue sections, 
make sure that enough water is present in the humid chamber during the overnight incubation.  

PLA® Probe Incubation:

7. Bring the coverslips or slides that have been incubating in primary antibodies at 4°C or 37°C in 
step 6 to room temperature. 

8. Mix the two PLA® probes (PLUS and MINUS commercial stocks, or custom made probe(s), refer 
to Support Protocol #2 in this unit for details), and dilute 1:5 in the same buffer used for diluting 
the primary antibodies, or the antibody diluent provided  in the PLA probe kit. Prepare enough 
of the mix to cover the sample without it dyring out during the incubation time (e.g. for 15 mm 
round coverslips a 40 µl reaction is appropriate; use 8 µl of each probe and 24 µl of the antibody 
dilution buffer). Let this cocktail sit for 20 minutes at room temperature before adding to the 
coverslips or slides.  

Custom probe kits can be purchased for the generation of PLUS or MINUS probes and the 
generated probes can be paired with standard, commercial probes at this step.
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9. Tap off the primary antibody by touching the edge of the coverslip or slide against a piece of 
filter paper or a Kimwipe® and wash two times with 1× Wash Buffer A, incubating 5 minutes 
each (recipe included in this unit). Washing steps can be performed by pipetting and aspirating 
Wash Buffer A while flat in the humid chamber. If desired, staining jars or dishes may be used for 
tissue sections and can be placed on an orbital shaker for gentle shaking during the wash step to 
enhance the effectiveness of the washing steps. 

At this step and all the following steps, cells on coverslips can be placed in the humid chamber 
cell-side up.

10. Tap off the 1× Wash Buffer A by touching the edge of the coverslip or slide against a piece of 
filter paper or a Kimwipe® and immediately add the diluted PLA probe mixture made in step 8, 
above. Incubate coverslips or slides in a humid chamber at 37°C for 1 hour.  

Keep the amount of residual wash buffer and the amount of probe cocktail the same among 
samples to maintain consistency. 

Ligase Incubation:

11. Bring the coverslips or slides that have been incubating with the PLA probes at 37°C in step 10 to 
room temperature.

12. Tap off the PLA probe solution by touching the edge of the coverslip or slide against a piece of 
filter paper or a Kimwipe® and wash the coverslips or slides two times in 1× Wash Buffer A, 
incubating for 5 minutes each.

13. During the washes, dilute the Ligation Stock Buffer (5×) 1:5 in high purity water.  After the final 
wash is complete, add the Ligase at a dilution of 1:40 to the diluted ligation buffer (e.g. for a 40 
µl volume, add 8 µl 5× Ligase buffer to 31 µl high purity water and 1 µl Ligase enzyme).   Keep 
the Ligase in a freeze block. 

14. Tap off the 1× Wash Buffer A by touching the edge of the coverslip or slide against a piece of 
filter paper or a Kimwipe® and add the diluted Ligase solution from the previous step to the 
coverslips or slides.

15. Incubate the coverslips or slides at 37°C for 30 minutes in the humid chamber.

Amplification Incubation:

16. Bring the coverslips or slides that have been incubating with the ligase solution at 37°C in step 
15 to room temperature.

17. Tap the Ligase solution by touching the coverslip or slide against a piece of filter paper or a 
Kimwipe® and wash 2 times with 1× Wash Buffer A, incubating for 2 minutes each. 
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18. During the washes, dilute the Amplification Stock Buffer (5×) 1:5 in high purity water.  After the 
final wash is complete, add the Polymerase enzyme at a dilution of 1:80 to the diluted 
amplification buffer (e.g. for a 40 µl volume, add 8 µl 5× Amplification buffer to 31.5 µl high 
purity water and 0.5 µl Polymerase enzyme).   Keep the Polymerase in a freeze block.

 
19. Make certain to remove as much of the 1× Wash Buffer A from the coverslips or slides as 

possible by wicking it away with filter paper or a Kimwipe® before adding the 
Amplification/Polymerase solution from the previous step. 

20. Incubate the coverslips or slides in the humid chamber at 37°C for 100 minutes.

The Amplification stock contains light sensitive reagents, so at this step and moving forward take 
care to protect the samples from light by using a dark humid chamber, or covering the chamber 
with tin foil to prevent fading of the fluorophores.

Increasing the amount of time at the amplification step can increase the amount of PLA signal, 
but it can increase non-specific background, or cause the coalescence of PLA spots, limiting the 
type of quantification that can be done to determine the amount of PLA signal per field of view.

 Washing and Mounting the slides:

21. Bring the coverslips or slides that have been incubating in the amplification solution at 37°C in 
step 20 to room temperature.

22. Tap the Amplification/Polymerase solution from the coverslips or slides by touching the 
coverslip or slide against a piece of filter paper or a Kimwipe®.

23. Wash the coverslips or slides 2 times with 1× Wash Buffer B, incubating for 10 minutes each 
time.  

If a primary antibody was added for counterstaining in step 4, wash samples in 1× Wash Buffer A 
for 1 min following step 23. Add secondary antibody and incubate the coverslips or slides for 30 
min at 37°C in the humid chamber. Tap off the antibody solution by touching the edge of the 
coverslip or slide against a piece of filter paper or a Kimwipe®. Wash coverslips or slides 2 times 
with 1× Wash Buffer A for 2 min before proceeding to step 24. 

If the mounting medium does not contain DAPI, incubate the coverslips or slides for 2 minutes 
with 1 µg/ml DAPI at room temperature. Wash coverslips or slides 3 times with 1× Wash Buffer B 
for 2 min before proceeding to step 24. DAPI can be useful for quantification of the PLA signal 
when plotting PLA signal as PLA signal area/image, PLA signal area/cell or the number of PLA 
spots/cell within the field of view.
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24. Wash the coverslips or slides one time with 0.01× Wash Buffer B, incubating for 1 minute.

25. Tap off the 0.01× Wash Buffer B by touching the edge of the coverslip or slide against a piece of 
filter paper or a Kimwipe® and allow the samples to air dry completely before mounting. 

Completely air drying the sample at this stage is important for optimal PLA signal.

26. Mount the coverslips or slides with a minimal amount of mounting medium using either 
Duolink™ In Situ Mounting Medium with DAPI, or another mounting medium (e.g. for a 15 mm 
coverslip 10-20 µl of mounting medium is appropriate). Excess mounting medium that leaks 
from underneath can be carefully suctioned off using a pipette or by vacuum, or by placing a 
Kimwipe® on top of the coverslip to wick away the excess.  Slides can be stored flat and in the 
dark at 4°C for several days without significant loss of signal.  

Duolink™ In Situ Mounting Medium with DAPI will not solidify. Before mounting, use a Kimwipe®, 
filter paper, or a cotton swab soaked with water to carefully remove salt and debris from the 
non-cell side of the coverslip. Attempts to clean the surface after mounting will result in 
movement of the coverslip. Store slides flat to avoid coverslip movement.  Applying nail polish 
around the coverslip edge, or using solidifying mounting media can decrease the amount of 
coverslip movement, allowing for imaging with high power immersion lenses. Use of a different 
mounting media may result in the PLA signal fading more quickly than when using the 
recommended reagent.

27. Refer to the subsequent Basic Protocol #2 for Imaging, Quantification and Analysis of PLA 
signals.

Support Protocol #1: Antigen retrieval method for formalin fixed paraffin-embedded tissues

Formalin fixation cross-links protein, making antigens inaccessible to antibodies. The antigen retrieval 
protocol combines high temperature with buffers at low pH to unmask antigenic determinants.

Materials

 4-5 µm Sections on Superfrost Plus slides (VWR cat. no. 48311-703) from tissues fixed 
with 10% (v/v) neutral buffered formalin and embedded in paraffin. Tissue processing 
and sectioning are standard procedures and usually performed in a dedicated histology 
laboratory.

 Staining dishes with slide racks or Coplin jars containing
o Xylene 
o 100% ethanol 
o 70% ethanol
o PBS 

1. Bake slides at 60oC, overnight to melt paraffin and dry the tissue.
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2. Place slides in a staining dish containing xylene for 3 minutes, repeat twice with fresh xylene.

3. Dehydrate the tissues by transferring the slides to a staining dish containing 100% ethanol for 3 
minutes, repeat twice with fresh 100% ethanol.

4. Transfer the slides to a staining dish containing 70% ethanol and incubate 3 minutes.

5. Transfer the slides to a staining dish containing PBS and incubate 3 minutes, repeat twice with 
fresh PBS.

6. Transfer the slides to a staining dish containing PBS and incubate 3 minutes.

The solutions should be replaced after processing ~50 slides, or at least every 2 weeks. 

7. Permeabilize the tissue sections by incubating in 0.5% Triton X-100 in PBS for 10 minutes.

8. Incubate the slides in 0.01 M Citrate buffer (pH 6.0) at 95oC for 15 minutes. This can be done by 
placing the slides in a dish on a hot plate. Monitor the temperature with a thermometer. Do not 
allow the citrate buffer to come to a boil.

9. Remove the dish from the hot plate and allow the citrate buffer to cool to room temperature. 

10. Wash the slides by placing them in a staining jar containing PBS and incubating for 3 minutes at 
room temperature; repeat two more times with fresh PBS.

11. Continue with the PLA protocol detailed in Basic Protocol #1, step 3, blocking non-specific 
antibody binding.

A grease pen or PAP Pen can be used to create a hydrophobic barrier around sections. Use 
caution with pap pens, as they may interfere with the PLA reaction, or visualization of PLA 
signal when detergent in included in primary antibody diluents and/or PLA probe solutions (see 
Troubleshooting).

Support Protocol #2:  Creating custom PLA probes using the Duolink™ In Situ Probemaker Kit when 
commercially available probes are not suitable 

Custom probe kits can be purchased for the generation of PLUS or MINUS probes and the generated 
probes can be paired with standard, commercial probes.

Create unique probes in the event that the commercially available kits will not suffice, such as

o When the 2 antibodies for pair recognition are from the same species.
o When the antibody species you have is not one of the commercially available reagents 

(mouse, rabbit, goat or human). 
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o When visualizing a homodimer. The same antibody can be labeled with each probe (Plus 
and Minus) (Ota et al., 2017). 

o When using antibodies derived from the same species as the tissue sample, such as 
mouse antibodies to stain mouse tissue. This eliminates the need to use anti-mouse 
secondary antibodies that may cause high background in traditional 
immunohistochemistry from recognition of endogenous mouse IgG.

o Note: Certain antibody specifications must be met:
 The antibody concentration must be at 1 mg/ml or greater.
 20 µl volumes should be used for conjugation of the probe. Concentrating dilute 

antibodies is not recommended.
 The antibody must be in an amine, carrier and preservative free buffer, but may 

contain up to 0.1% BSA, 5% trehalose, and 0.02% sodium azide. 
 If a monoclonal antibody is used, it should be Protein A or Protein G affinity 

purified.

Materials

 Antibody to be labeled with the Duolink™ Probemaker kit
 Duolink™ PLA Probemaker kit (Probemaker PLUS: 

https://www.sigmaaldrich.com/catalog/product/sigma/duo92009 ; Probemaker MINUS: 
https://www.sigmaaldrich.com/catalog/product/sigma/duo92010)

 Duolink™ PLA lyophilized PLUS or MINUS oligonucleotides 

 Conjugation Buffer

 Stop Reagent

 Storage Solution 

 20× Assay Reagent 

 Blocking Solution 

 PLA Probe Diluent. This should be used in substitution of the Duolink™ Antibody 
Diluent found in the basic kit. 

Store all reagents at -20°C. Once the antibody is conjugated, store at 4°C.

 

Protocol steps

1. Add 2 µL of Conjugation Buffer to 20 µL of the antibody and pipette gently to mix. The antibody 
concentration should be 1 mg/ml.

2. Open a vial of lyophilized oligonucleotides and immediately add the above antibody solution. 
Pipette gently to mix. 

3. Incubate at room temperature overnight.
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4. The next day add 2 µL of Stop Reagent to the reaction. Pipette gently to mix.

5. Incubate at room temperature for 30 minutes.

6. Add 24 µL of Storage Solution to the stopped reaction. Pipette gently to mix.

7. The PLA probe(s) may be used immediately, or stored at 4°C. They can be paired with a 
commercial PLA probe in Basic Protocol #1.

Basic Protocol #2: Imaging, quantification and analysis of PLA signals

Images can be quantified using a variety of analysis software packages, such as ImageJ/FIJI. Data may be 
presented as number of PLA spots observed per field or the number of PLA spots observed/number of 
cells in the field, but PLA signals may coalesce, resulting in under sampling. Consequently, when a strong 
interaction is observed, present data as the area of PLA signal per field (not signal intensity) or the area 
of PLA signal per field/number of cells.

Quantification can be plotted as (1) the number of spots per field, (2) the number of 
spots/number of cells within the field as determined by DAPI counterstaining, (3) area of PLA 
signal per field, or (4) by area of PLA signal per field/number of cells.

Materials and Equipment:

 Widefield or confocal fluorescence microscope equipped with excitation and emission filters 
that are compatible with the fluorophore and nuclear stain from the chosen kit, air objectives 
(e.g. 20× (NA 0.4), 20× (NA 0.8), or 40× (NA 0.7)) and software for image acquisition. If using a 
solidifying mounting medium, or sealing the coverslip with nail polish, then a high NA immersion 
objective (e.g. 63× (NA 1.4)) can be used to yield higher quality PLA images.

 Program to obtain objective quantification of PLA fluorescence signals (e.g. Image J/FIJI, NIH, 
http://imagej.nih.gov/ij). 

 Programs such as Microsoft® Excel or GraphPad Prism® used to graph the data from the 
analysis.

Imaging

1. Imaging with a widefield fluorescence or confocal microscope can be done using a 20× or 40× air 
objective as early as 15 minutes after mounting. If using a solidifying mounting medium, or 
sealing the coverslip with nail polish, a high NA immersion objective (e.g. 63×, NA 1.4) can be 
used to yield higher quality PLA images the day after mounting.
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Any of the mounting media that has leaked from underneath the coverslip may make it difficult 
to form a seal, so careful handling and flat storage of the samples must be performed after the 
application of polish. Excess mounting media can be removed by suctioning off with a vacuum or 
a pipette. Note that Sigma Aldrich recommends use of the Duolink In Situ mounting media as use 
of a different mounting media may result in the PLA signal fading more quickly than when using 
the recommended reagent.

Imaging a single focal plane is usually sufficient to analyze the PLA signal for cell monolayers and 
may be sufficient for thin >5 um tissue sections. For thicker samples, such as multilayer cell 
cultures or tissue sections, it is advisable to perform confocal imaging with a high NA immersion 
objective, capturing multiple z-planes and merging them into a maximum intensity projection. 
Using high NA immersion objectives will  enhance the resolution of high-density PLA signals to 
resolve coalesced PLA dots observed in lower NA objectives, enhancing the accuracy of the 
number of PLA dots quantified. Alternatively, quantifying the signal area can bypass the need for 
high NA immersion objectives when using a lower NA air objective. 

2. Collect images of the PLA signal first to avoid bleaching, followed by the channel used for 
counterstain, if applicable, and the image of the DAPI channel. 

Apply the same acquisition parameters (camera settings and exposure times) between samples 
when collecting PLA signal images. It is best to use the strongest stained sample (usually the 
positive control) when setting camera settings and exposure times to prevent image saturation. 
PLA results can vary from experiment to experiment; therefore, collect data from positive and 
negative controls for each experiment.

Quantification using ImageJ/FIJI

Quantification can be plotted as (1) the number of spots per field, (2) the number of 
spots/number of cells within the field as determined by DAPI counterstaining, (3) area of PLA 
signal per field, or (4) by area of PLA signal per field/number of cells. 

3. Choose an Auto Threshold method for the PLA signal: Image>Adjust>Auto Threshold>Try all and 
choose a preferred auto-threshold method. Threshold with the preferred method: 
Image>Adjust>Threshold>click the down arrow to change Default to the chosen method>Apply 
(makes binary image to use for the watershed function, if measure the PLA signal area then you 
do not need to click “Apply”). Keep auto-threshold method consistent between experimental 
groups.

Alternatively, if the samples are processed and the imaged the same, then you can use a fixed 
threshold by setting the Min and Max threshold and keeping this threshold limit consistent 
between experimental arms. However, auto-thresholding is recommended to enhance 
reproducibility. 

4. Go to Analyze>Set Measurements and make sure Area and Limit to threshold is checked.
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5. To measure PLA signal area: Analyze>Measure. The area of PLA signal will be in the area column 
of the resulting table (you do not want the mean, which is the signal intensity).

Alternatively, the number of PLA dots can be quantified using ImageJ/Fiji by segmenting 
coalescing signals using Process>Binary>Watershed and counting the number of dots using 
Analyze>Analyze Particles. This method is only advisable if the dots are well separated in the 
image in all conditions.  Particles that are closer than the resolution limit of the objective lens will 
coalesce, not allowing one to distinguish individual protein-protein interactions. The resolution 
can be calculated by the formula 0.61 * λ / NA where λ is the wavelength and NA is the 
numerical aperture of the objective used to image the sample. If the dots are dense in the 
images and may comprise multiple spots it is recommended that average intensity/area be used 
for quantification. 

6. To manually count the number of DAPI positive nuclei: Plugins>Analyze>Cell Counter>Cell 
Counter. Click Initialize under Actions and Type 1 under Counters. To count the DAPI nuclei click 
on each cell nuclei on your Counter Window image. 

Alternatively, if you do not have multinucleated cells, you can automize the number of DAPI 
nuclei similar to quantifying the number of PLA dots: by segmenting overlapping nuclei using 
Process>Binary>Watershed and counting the number of DAPI positive cells using 
Analyze>Analyze Particles.

7. In Microsoft® Excel, divide the PLA signal area to the number of DAPI positive nuclei to get the 
amount of PLA signal area/DAPI positive nuclei. Calculate the Average PLA signal 
area/image/image/image or PLA signal area/number of cells for each independent experiment.

8. Graph your data along with relevant controls using programs such as Microsoft® Excel or 
GraphPad Prism®  and perform statistical analysis tests, such as t-test (experiments with two 
experimental arms) or one-way ANOVA with an appropriate Post hoc Test (experiments with 
more than two experimental arms).

Reagents and Solutions—all solutions are made with high quality water 

4′,6-diamidine-2′-phenylindole dihydrochloride (DAPI) 
Stock solution: 1 mg/ml diluted in water

 May need to sonicate, or put at 65°C to completely dissolve powder. Alternatively, 
dimethylformamide (DMF) can be used in place of water for stock solution.

 Store stocks at -20°C in the dark

Working solution: 1 µg/ml in 1× Wash buffer B or PBS
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 Dilute stock solution 1:1,000 in 1× Wash Buffer B or PBS. 
 Incubate samples for 2 minutes at room temperature.
 Wash 3 times with 1× Wash buffer B.
 Make from stock solution when ready to use

4% Paraformaldehyde
Paraformaldehyde 0.8 g 
H2O qs to 10 ml
10 N NaOH dropwise
0.2M NaPO4 buffer 10 ml

 Use caution when working with the paraformaldehyde and do all work from dispensing 
the power, heating the solution and fixing the cells under a fume hood to avoid 
inhalation.

 Heat the 0.8 g paraformaldehyde in 10 ml water and heat to 65°C on a hot plate while 
stirring gently. Do not let the temperature of the solution exceed 65°C.

 Add 10 N NaOH dropwise to the heated solution slowly during a 5-10 minute period to 
get all of the paraformaldehyde powder into solution.

 Add 10 ml 0.2 M Sodium Phosphate buffer, pH 7.4 (refer to above recipe)
 Let cool to room temperature before using the solution to fix cells or tissue sections.
 Best made fresh, though aliquots can be stored for several days at 4°C or for several 

months at -20°C.

Detergent Permeabilization/Blocking Buffer 
0.2% Triton X-100 
1% Bovine Serum Albumin 
Dilute in PBS

 Filter sterilize and store stocks at 4°C for several months

Duolink™ Wash Buffers (A and B)
**Pouches containing the chemicals are available for purchase from Sigma Aldrich. Recipes are included 
below:

In Situ Wash Buffer A—pH 7.4
NaCl 8.8 g
Tris Base 1.2 g
Tween 20 500 µl
H2O 800 ml
HCl to pH to 7.4
H2O qs to 1 L

 Filter sterilize and store stocks at 4°C

In Situ Wash Buffer B—pH 7.5
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NaCl 5.84 g
Tris Base 4.24 g
Tris-HCl  26 g
H2O 500 ml
HCl to pH to 7.5
H2O qs to 1 L 

 Filter sterilize and store stocks at 4°C

Phosphate Buffered Saline (PBS) 1 Liter
NaCl 8 g
KCl 0.2 g
Na2HPO4·7H2O 2.17 g
KH2PO4 0.2 g
H2O qs to 1 L

 Store stock at room temperature

Sodium Citrate Buffer

0.1 M sodium citrate (Sigma-Aldrich)
pH 6.0
 Make fresh at the time of use

0.2 M Sodium Phosphate Buffer pH7.4
NaH2PO4 (monobasic) 0.53 g
Na2HPO4 (dibasic) 4.34 g
H2O qs to 100 ml
pH to 7.4

 Store stock at room temperature

Alternatively, combine monobasic and a dibasic Sodium Phosphate stocks (recipes below) to 
obtain the desired pH of 7.4. Mix 19 ml of the monobasic stock solution below with 81 ml of the 
dibasic stock solution below to obtain a sodium phosphate solution with a pH of 7.4.

NaH2PO4 (monobasic) Stock Solution
27.6 g monobasic monohydrate 
qs to 1 Liter with water

 Store stock at room temperature

Na2HPO4 (dibasic) Stock Solution
28.4 g dibasic 
qs to 1 L with water

 Store stock at room temperature
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COMMENTARY

Background Information

The Proximity Ligation Assay (PLA) was first designed using DNA aptamers that recognized target 
proteins. The aptamers contain extended sequences that recognized an additional connecting 
oligonucleotide. If in close enough proximity, the two aptamers would ligate together. This ligated 
sequence served as a template for PCR resulting in amplification that could be quantified (Fredriksson et 
al., 2002).  The method was then modified by attaching oligonucleotides to primary antibodies, making 
use of available antibody reagents instead of designing target sequences for each experiment (Gullberg 
et al., 2004).  Further modifications of the technique included the application of rolling circle 
amplification, which enhanced the signals and allowed for in situ visualization of low frequency events 
(Söderberg et al., 2006). The technique has become more widely utilized since the assay was redesigned 
to link oligonucleotides to secondary antibodies and made commercially available in 2007 by Olink 
Bioscience along with standardized ligation and amplification conditions (Figure 1).  The Duolink™ 
technology designed and marketed by Olink® (https://www.olink.com/about-us-olink-biomarker-
discovery/#) was recently sold to Sigma-Aldrich in 2015 
(https://www.genengnews.com/topics/bioprocessing/sigma-aldrich-buys-duolink-portfolio-from-olink/). 
Recently, a variation of the PLA technique was developed to enhance the efficiency and sensitivity of the 
assay, but is not yet commercially available (Klaesson et al., 2018). PLA has also been adapted to 
accommodate high-throughput imaging to observe large-scale changes in protein interactomes and to 
test the efficacy of individual compounds from small molecule libraries (Mendez & Banerjee, 2017).

Biochemical methods provide information about protein-protein interactions in cells, and the use of 
biosensors utilizing fluorescent proteins can bring in the added information of the subcellular 
localization of protein-protein interactions (Sam Duwé & Dedecker, 2019). Likewise, PLA reveals protein 
interactions in situ, but the standardized protocol relieves the difficulties associated with the design of 
fluorescent constructs and opens up the ability to look at endogenous proteins (Figures 2-5).  This is 
particularly useful in cases where material is limited and/or genetic manipulation is not possible, such as 
when working with clinical samples (Figure 5). The use of PLA in mouse, Drosophila, and human/clinical 
tissue has been applied to multiple studies to investigate protein-protein interactions including the 
following references (Bagchi, Fredriksson, & Wallén-Mackenzie, 2015; Doebele et al., 2015; Harmon et 
al., 2013; Mannix, Starble, Kaufman, & Cooley, 2019; Mendez & Banerjee, 2017; Ruffmann et al., 2018; 
Sartori et al., 2019; Taura, Fernández-Dueñas, & Ciruela, 2015). By combining antigen detection via 
antibody with PCR amplification, interactions that would otherwise be difficult to detect are able to be 
visualized and quantified while eliminating background signals.  Thus, PLA can be used to detect single 
proteins that have low levels of endogenous expression and visualize rare protein-protein interactions 
within a cell and has been used to detect an interaction of two different proteins expressed on different 
cell types (Sable et al., 2018). This technique can also be applied for the detection of post-translational 
protein modifications (Figure 3). The versatility of PLA makes this a useful technique for the cell biology 
laboratory. 
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Critical Parameters

To ensure success, the antibodies for the assay must be carefully chosen and the parameters that result 
in optimal antibody binding should be determined prior to applying the PLA technique. These 
parameters include antibody concentration/dilution, the fixation/permeabilization conditions that allow 
for optimal epitope recognition and blocking conditions to minimalize background/non-specific staining. 
To be able to utilize the Duolink™ pre-made probes the antibody pairs must also be from two different 
species and of the IgG class generated in mouse, rabbit, goat or human.  A Probemaker kit is available 
with which probes can be generated using primary antibodies of different species or of the same species 
as long as certain specifications for those antibodies are met (refer to Support Protocol #1). 

Positive and negative controls are important considerations for the assay.  Positive controls include 
traditional immunofluorescence with the antibodies used in the PLA to demonstrate successful antibody 
recognition, as well as including a well-vetted PLA pairing that works in the cell type being analyzed that 
is run in parallel (Figure 2). As a negative control, it is most desirable to silence each protein of the pair 
in turn to determine the level-of background signals. Traditional immunofluorescence and western 
blotting should be included to demonstrate that silencing was successful.  If silencing is not possible, 
pre-immune serum for each antibody or non-specific IgG from the same species can be used. However, 
non-specific IgG can be problematic, as the concentration of the specific antibodies used are not known 
and thus one is unable to add the comparable amount of non-specific IgG to the control sample.  In the 
case of clinical specimens, control tissues are important for determining background PLA signal and if 
possible should be collected from the same body region and processed at the same time as the patient 
material. Analyzing non-lesional and lesional areas from the same patient is the ideal situation to 
observe differences in the affected areas; however, if that is not an option it is beneficial to validate 
results using in vitro models when possible.

For clinical specimens, when material is often limiting, analysis should be performed on at least 3 
separate sections, if possible from separate patient biopsies, collecting intensity measurements at 5 
regions across each tissue section. For cell monolayer experiments, a population analysis of three 
independent biological repeats should be performed, collecting intensity measurements from 5-10 areas 
across the coverslip to survey 25-50 cells per experimental arm. A population analysis and biological 
repeats are necessary to control for the amount of variation that can be observed among imaged areas 
of the same sample as well as the variation observed between biological repeats. An example of the 
variation that can be observed in a single experiment is shown in the quantification of Figures 2C (cell 
monolayers), 4B (3D organotypic cultures), and 5C, where each data point in the graph indicates the 
area of PLA signal per field/number of cells in a region of a coverslip (Figure 2C), or area of PLA signal per 
field in the tissue sections (Figure 4B, 5C). In these figures the error bars represent the standard 
deviation of the data. 

Troubleshooting

Sigma-Aldrich has an appendix containing general troubleshooting guidelines in the user guide for 
Duolink™ In Situ Fluorescence (https://www.sigmaaldrich.com/technical-
documents/protocols/biology/duolink-troubleshooting-guide.html). In general, the most commonly 
experienced problems are the inability to detect any signal, very weak signals barely above background, 
or the presence of significant non-specific PLA signal. Some tissues and cells may exhibit 
autofluorescence in the green channel, thus the Green detection reagent should be avoided in such 
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instances (λEx 495nm/ λEm 527nm). Optimization of the antibody recognition of the proteins in the PLA 
pairing via traditional immunofluorescence methods will increase specific PLA signal. Furthermore, one 
must ensure that there is very little residual wash buffer left on the slides to prevent the ligation and 
amplification solutions from unwanted dilution. Incubations at 37°C and adherence to the 
manufacturer’s recommended incubation times (1 hour for the probe incubation, 30 minutes for ligation 
and 100 minutes for the amplification) are also important for maximizing PLA signal.  Non-specific PLA 
signal can result from insufficient blocking to inhibit non-specific antibody binding or antibody 
concentrations that are too high. Another common reason for non-specific PLA signal deposition is 
drying out of the sample during one or more steps of the procedure before the final 0.01x Wash Buffer B 
step (Step 25). Incubations should be performed in a humid chamber and solutions should be of 
sufficient volume to cover the specimen without evaporation during the incubation times. The edges of 
the coverslip are most apt to dry out during incubations, resulting in the formation of salt crystals and 
higher PLA signals. Therefore, the investigator should avoid coverslip edges when collecting images. The 
coverslips or tissue samples are dried ONLY at the end of the PLA procedure directly prior to mounting 
after a final wash with 0.01x Wash Buffer B to avoid the deposition of salt crystals. The use of de-ionized 
water or lower purity water may result in a decrease of PLA signals, so high purity water is important 
when making solutions. For PLA performed on tissue sections where a pap pen is used to create a 
hydrophobic circle around the tissues, detergent should not be present in the blocking buffer, and the 
antibody and PLA probe diluent to avoid weak or non-specific PLA signal and high background signal. 
Alternatively, a grease pen can be used to create the hydrophobic barrier.

Anticipated Results

Figures 2-5 illustrate examples of expected results when performing PLA to look at protein-protein 
interactions and post translational modifications in 2D and 3D culture models, as well as in clinical 
specimens. Figure 2 demonstrates results of PLA in 2D epithelial monolayers to analyze protein-protein 
interactions.  Antibodies recognizing E-cadherin and β catenin, two components of the cell-cell adhesive 
junction, the adherens junction, reveal the proximity between two proteins that are known to interact 
directly biochemically. An antibody against another cell-cell junction associated protein, plakoglobin, is 
used as a counterstain to demarcate cell membranes and attribute spatial relevance to the PLA 
signature. Refer to Rüsbaum et al for a review on cell-cell junctions (Rübsam et al., 2018).   In Figure 3, 
the ability of PLA to reveal post-translational modifications of Epidermal Growth Factor Receptor (EGFR) 
are presented. An antibody recognizing EGFR is used in combination with an antibody recognizing 
Ubiquitin or Nedd8, a ubiquitin-like protein (Najor et al., 2017).  In this experiment, the authors’ 
questioned whether Nedd8 and Ubiquitin could compete for lysine residues on EGFR. Through the loss 
of a de-neddylating mechanism (siCOPS3), the authors noted that EGFR displayed a lower EGFR-
ubiquitin PLA signal when compared to control, suggesting that Nedd8 moieties were potentially 
blocking Ubiquitin moieties. In Figure 4 and 5, antibodies recognizing Desmoglein 1 and Plakoglobin, two 
components of the cell-cell adhesive junction, the desmosome, are used to demonstrate the interaction 
between these two proteins and attribute a spatial signature to the interaction within a 3-dimensional 
organotypic culture model of human skin and in clinical biopsies. In Figure 4, paraffin-embedded 
sections of 3D organotypic cultures mimicking the epidermal layers of human skin are used to 
demonstrate the utility of PLA in sections. This epidermal organotypic culture is grown on an air-liquid 
interface and is a powerful model for understanding human skin function. They can be generated using 
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primary keratinocytes isolated from human foreskin, or biopsy material and by keratinocytes derived 
from iPS cells. Refer to Arnette et al for a protocol on how to culture these 3 D models (Arnette, 
Koetsier, Hoover, Getsios, & Green, 2016). In the example in Figure 5, the patient biopsy was obtained 
from an individual afflicted with Severe dermatitis, multiple Allergies and Metabolic wasting (SAM) 
syndrome, a skin disease associated with a loss of Desmoglein 1 expression at the cell-cell adhesive 
interface (Dsg1 p.R887X), and this loss is quantifiable using the PLA assay (Eran Cohen-Barak et al., 2020; 
Samuelov et al., 2013).

Time Considerations

The Duolink™ procedure contains a number of long incubation steps; therefore, it is recommended that 
the protocol be carried out over 2 days. The slides are best imaged within the first few days of the 
completion of the protocol and can be imaged as early as 15 minutes after mounting, when using a non-
solidifying mounting media. Store the slides flat and in the dark at 4°C or -20°C until imaging. 
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 Internet Resources

https://www.olink.com/about-us-olink-biomarker-discovery/#

Website of Olink, the first marketers of the PLA procedure.

https://www.genengnews.com/topics/bioprocessing/sigma-aldrich-buys-duolink-portfolio-from-olink/) 

Website describing the purchase of the Duolink® Product Portfolio

https://www.sigmaaldrich.com/life-science/cell-biology/antibodies/duolink-and-pla-
technology/resource-center.html

Website for the Sigma Aldrich resource center for PLA, including assay optimization information, a 
product selection guide and a link to troubleshooting tips and FAQs.

https://www.sigmaaldrich.com/technical-documents/protocols/biology/duolink-troubleshooting-
guide.html

Website for the Sigma Aldrich PLA troubleshooting guide

https://www.sigmaaldrich.com/catalog/product/sigma/duo92202

Website for the product catalog of Sigma Aldrich PLA kits and components.

Figure Legends

Figure 1. Schematic presenting the principal of the Proximity Ligation Assay® (PLA) for the detection of 
two proteins within a proximity of ≤ 40nm. (1) Two antibodies of different species are selected that 
recognize two proteins of interest. (2) Secondary antibodies that recognize the Fc regions of the primary 
antibody species are conjugated with oligonucleotide probes and then incubated with the sample. (3) 
Ligase and free oligonucleotides that hybridize with the probes bring the oligonucleotides together in a 
closed circle confirmation if the proteins are in close enough proximity. (4) Finally, polymerase is added 
to the reaction to allow for rolling circle amplification, while fluorescently labeled oligonucleotides 
hybridize with the rolling circle product resulting in the accumulation of a fluorescent spot in areas of 
successful amplification. 

Figure 2. PLA applied to cell monolayers demonstrating protein-protein interactions in situ. Antibodies 
recognizing components of the cell-cell adhesive junction, the adherens junction, are used here to 
demonstrate the ability to visualize proximity between two proteins and attribute a spatial signature to 
the interaction within the 2-dimensional cell monolayer.  For a review on the cell-cell junctions, the 
desmosome and the adherens junction refer to Rübsam et al (Rübsam et al., 2018). A. The 
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transmembrane protein, E-cadherin (antibody: HECD-1 mouse) and its cytoplasmic binding partner β-
Catenin (antibody: C2206rabbit) demonstrated the use of PLA to reveal protein-protein interactions in situ, 
visualized by PLA reaction “spots” shown in red (Duolink™ In Situ Detection Reagent Red, λEx: 594, λEm: 
624).  Plakoglobin  (antibody: 1407chicken, white), a constituent of the adherens junction and its related 
cell-cell junction, the desmosome, is used as an immunofluorescent counterstain to reveal the location 
of cell-cell borders in the monolayer to give spatial relevance to the location of the PLA reaction. DAPI 
labels nuclei in blue.  Controls for the assay include combining each primary antibody with pre-immune 
sera of the opposite species used (anti-E-cadherinmouse paired with IgGrabbit (rbIgG) and β-Cateninrabbit 
paired with IgGmouse (mIgG)). A highly recommended control is the silencing of the proteins of interest. 
Note the decreased PLA signal in the siRNA silenced samples in A (siβ-Catenin, siE-Cadherin). B. 
Traditional immunofluorescence (IF) using the antibodies at the same concentrations as used in the PLA 
reaction is performed to demonstrate successful antibody binding and to observe the effect of E-
cadherin and  β-Catenin silencing (E-cadherin or β-Catenin, white; DAPI, blue).  C. Quantification of PLA 
signal. Data points in the graph indicate the area of PLA signal per field/number of cells in the field. DAPI 
was used to determine cell number. Error bars indicate the standard deviation. ImageJ/FIJI was used for 
image analysis and data graphed using GraphPad Prism®. D. Western blot analysis was done in parallel 
to assess the efficiency of siRNA-mediated knockdown for each protein. Note that the knockdown of E-
Cadherin resulted in a decrease in β-Catenin levels, reflected in the slightly lower amount of PLA signal 
observed in the siE-Cadherin condition. PLA images were acquired using a DMR Leica microscope with a 
40X (PL Fluortar, NA 0.7) using a Hamamatsu Orca 100 CCD camera model C4742-95. Traditional 
immunofluorescence images were acquired using an AxioVison Z1 system (Carl Zeiss) with Apotome 
slide module, an AxioCam MRm digital camera, and a 40x (0.5 NA, Plan-Neofluar) objective.  Scale bar = 
10 µm.

Figure 3. Utilizing PLA to detect specific post-translational protein modifications in situ. EGFR is 
stabilized at the plasma membrane in part by the process of neddylation, the addition of Nedd 8 
moieties on the C-terminus. De-neddylation is mediated by a large protein complex, the COPS9 
signalosome, and results in the ubiquitination of EGFR and turnover of the receptor (Najor et al., 2017).  
A. PLA using an antibody pair recognizing EGFRmouse and the Nedd 8 moietyrabbit demonstrate the level of 
the post-translational modification of EGFR in the epithelial cells, visualized by PLA reaction “spots” 
shown red (Duolink™  In Situ Detection Reagent Red, λEx: 594, λEm: 624). Knock down of Nedd8 using 
siRNA technology resulted in the marked decrease in PLA signal. Other negative controls include the 
pairing of each specific antibody with a non-specific IgG counterpart (EGFRmouse:IgGrabbit or 
Nedd8rabbit:IgGmouse). DAPI labels nuclei in blue. B. De-neddylated EGFR (in siCONT panel) results in the 
ubiquitination of the receptor as seen by the strong PLA signal shown in red (Duolink™ In Situ Detection 
Reagent Red, λEx: 594, λEm: 624) when anti-EGFRrabbit is paired with anti-Ubiquitinmouse. As this process is 
regulated by the COPS9 signalosome, loss of an obligate constituent of the complex (siCOPS3 panel) 
results in a decrease in the EGFR ubiquitination, demonstrated by a marked decrease in PLA signal.  
Other controls shown: the pairing of each specific antibody with a non-specific IgG counterpart 
(EGFRrabbit:IgGmouse or Ubqmouse:IgGrabbit). DAPI labels nuclei in blue. Images were acquired using a DMR 
Leica microscope with a 40X (PL Fluotar, NA 1.0) using a Hamamatsu Orca 100 CCD camera, model 
C4742-95. Scale bar = 10 µm.

Figure 4. PLA applied to paraffin-embedded 3D organotypic cultures demonstrating protein-protein 
interactions in situ. Antibodies recognizing Desmoglein 1 (Dsg1goat) and Plakoglobin (Pgmouse), two 
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components of the cell-cell adhesive junction the desmosome, are used to demonstrate the ability to 
visualize proximity between two proteins. For a review on the cell-cell junctions, the desmosome and 
the adherens junction refer to Rübsam et al (Rübsam et al., 2018).  Paraffin-embedded sections of 3D 
organotypic cultures that mimic the epidermal layers of human skin, generated using primary 
keratinocytes isolated from human foreskin were processed for PLA. Refer to Arnette et al. for a 
protocol on growing such cultures (Arnette et al., 2016). A. A strong PLA signal (red) is observed in the 
control section (shCTL), and this specific signal is lost when Dsg1 is silenced (shDsg1) (Duolink™ In Situ 
Detection Reagent Red, λEx: 594, λEm: 624). DAPI labels nuclei in blue. B. In 3D cross sections, using DAPI 
as a measure of cell number is not reliable as not every cell will have a nucleus in the cross section; 
therefore, the sections are quantified and plotted as the average PLA signal area/field. Data points in the 
graph indicate the area of PLA signal per field in a region of the tissue. Error bars indicate the standard 
deviation. ImageJ/FIJI was used for image analysis and data graphed using GraphPad Prism®.  C. 
Immunofluorescence (IF) demonstrates successful binding of both antibodies in the control section, 
while staining is decreased in the Dsg1 knock down condition (Dsg1 or Pg in white, DAPI in blue). Images 
were acquired using an AxioVison Z1 system (Carl Zeiss) with Apotome slide module, an AxioCam MRm 
digital camera, and a 40x (0.5 NA, Plan-Neofluar) objective.  Scale bar = 20 µm.

Figure 5. Use of PLA to compare protein-protein interactions in clinical tissue specimens in situ.  The 
interaction between the desmosomal cadherin Desmoglein 1 (Dsg1goat) and its cytoplasmic partner 
Plakoglobin (Pgmouse) is analyzed in a paraffin-embedded SAM syndrome patient biopsy and compared to 
control tissue. SAM syndrome is a skin disease associated with a loss of Dsg1 expression at the cell-cell 
adhesive interface (Eran Cohen-Barak et al., 2020; Samuelov et al., 2013). A. The PLA signal is clearly 
decreased in the SAM syndrome patient section compared to control tissue (red, Duolink™ In Situ 
Detection Reagent Red, λEx: 594, λEm: 624). B. Traditional immunofluorescence assay performed on 
control tissue is used to demonstrate successful antibody binding to both proteins analyzed by PLA 
(Dsg1, red; Pg, green; DAPI, blue). C. In tissue sections such as this, using DAPI (blue) as a measure of cell 
number is not reliable as every cell will have a nucleus in the cross section; therefore, the PLA signal is 
quantified and plotted as the area of PLA signal per field. Data points in the graph indicate the area of 
PLA signal in a region of the tissue. Error bars indicate the standard deviation. ImageJ/FIJI was used for 
image analysis and data graphed using GraphPad Prism®.  Images were acquired using an AxioVison Z1 
system (Carl Zeiss) with Apotome slide module, an AxioCam MRm digital camera, and a 40x (0.5 NA, 
Plan-Neofluar) objective.  Scale bar = 50 µm.
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Significance Statement

The Proximity Ligation Assay is a versatile method useful for a variety of applications in the cell biology 
laboratory. This method is suitable for visualizing post-translational protein modifications, protein-
protein interactions, and amplifying signals to detect proteins and protein-protein interactions that are 
at low levels in cells and tissues while eliminating high background signals that may be associated with 
traditional immunofluorescence. The technique allows the investigator to determine the subcellular 
location of such events that are either transient or stable, and it can be used to visualize both ectopically 
expressed proteins as well as endogenous proteins. This is particularly useful in situations where genetic 
manipulation is not favorable or possible, such as when analyzing clinical samples. 

Abstract

Biochemical methods can reveal stable protein-protein interactions occurring within cells, but the ability 
to observe transient events and to visualize the subcellular localization of protein-protein interactions in 
cells and tissues in situ provides important additional information. Proximity Ligation Assay® (PLA) offers 
the opportunity to visualize the subcellular location of such interactions at endogenous protein levels, 
provided that the probes that recognize the target proteins are within 40nm. This sensitive technique 
not only elucidates protein-protein interactions, but can also reveal post-translational protein 
modifications. This technique is useful even in cases where material is limited, such as when paraffin-
embedded clinical specimens are the only available material, as well as after experimental intervention 
in 2D and 3D model systems. Here we detail the basic protocol for the commercially available Proximity 
Ligation Assay™ materials (Sigma-Aldrich, St. Louis, MO) and have incorporated details to aid the 
researcher in successfully performing the experiments.

Basic Protocol #1: Proximity Ligation Assay

Basic Protocol #2: Imaging, quantification and analysis of PLA signals

Support Protocol #1: Antigen retrieval method for formalin fixed paraffin-embedded tissues

Support Protocol #2:  Creating custom PLA probes using the Duolink™ In Situ Probemaker Kit when 
commercially available probes are not suitable

Keywords:

Proximity ligation assay®

Protein-protein interaction

Post-translational modification

In situ tissue staining

Duolink™
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3

Introduction:

This unit describes the powerful and sensitive technique of the Duolink™ Proximity Ligation Analysis® 
(PLA). This method provides an advantage over traditional immunofluorescence co-localization and 
biochemical immunoprecipitation methods in that the analysis of individual proteins, protein-protein 
interactions, or specific protein modifications is paired with the ability to observe the subcellular 
localization of the occurrence. Biochemical precipitation methods are suitable to detect stable 
interactions between proteins, but detection of more transient interactions may be overlooked and may 
be impossible in cases where material is limiting, such as when working with patient material. 
Subcellular localization can be obtained with other biotechnological fluorescence methods such as 
biomolecular fluorescence complementation, fluorescence resonance energy transfer (FRET), or 
optogenetics; however, these methods require the expression of ectopically expressed proteins, and 
design of the protein constructs can be fraught with difficulties (Sam Duwé & Dedecker, 2019). PLA 
offers the opportunity to visualize the subcellular location of endogenous protein interactions or 
modifications that are either transient or stable without the need of ectopically expressed proteins. This 
is particularly useful in situations where genetic manipulation is impossible or not favorable, such as 
when analyzing paraffin-embedded or frozen tissue sections. Utilizing investigator selected antibody 
pairs for detection of antigens, PLA can complement immunofluorescence assays as a sensitive method 
for detection and quantification while reducing the background and non-specific staining that may be 
observed using traditional immunofluorescence methods.

The PLA technique uses Duolink™ technology in which probes bind to the constant regions of primary 
antibodies. The probes are ligated together, hybridizing to form a circular DNA. Fluorescent- or HRP-
labeled oligonucleotides are then incorporated during the process of rolling circle amplification. This 
incorporation during amplification produces a fluorescent “spot” that can be visualized in cells and 
tissues by microscopy and quantified (Figure 1). This article outlines the procedure for Duolink™ 
fluorescent reagents and how to image, quantify and analyze PLA signals. Two support protocols 
describe the antigen retrieval method for formalin fixed paraffin-embedded tissues and creating custom 
PLA probes using the Duolink™ In Situ Probemaker Kit.

Strategic Planning:

Before embarking on a PLA experiment, the investigator must vet the antibodies to be used for the 
assay using a traditional immunofluorescence assay. Initially, the conditions for the antibodies should be 
optimized to determine the best fixation/permeabilization (e.g. methanol or paraformaldehyde followed 
by detergent permeabilization) and dilution for each antibody (Donaldson, 2015). Although there are 
solutions provided in the PLA kit, the investigator is encouraged to use custom blocking buffers and 
antibody diluents that work best for the desired immunofluorescence conditions.  A recipe for a solution 
that works well as both a blocking agent and antibody diluent is included in this unit.  The antibodies 
should be titrated to determine a dilution for each that maximizes recognition of the protein, while 
decreasing the amount of background observed during traditional wide-field immunofluorescence 
imaging. Furthermore, high titer of antibody can cause the distinct fluorescent spots to merge together, 
which limits quantification.  In general, the antibody pairs need to consist of antibodies from two 
different species, and there are a select number of species available when using the commercially 
available kit (mouse, rabbit, goat or human). When the same species must be used, or if a species is not 
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part of the select number available, there is a custom probe making kit that can be purchased and these 
custom probes can be combined with the commercially available probes (refer to Support Protocol #2 
below).  

Traditional immunofluorescence staining with the antibodies of the PLA pair should be included in 
parallel with the proximity ligation assay as a control to demonstrate effective binding by the primary 
antibodies in each experiment. Refer to protocols by Donaldson and Hoffman and Taylor for 
immunostaining of cells and immunohistochemistry of tissues (Donaldson, 2015; Hofman & Taylor, 
2013). Determination of successful immunofluorescence staining can be completed and confirmed before 
moving forward with the rest of PLA protocol. Controls to demonstrate specificity of the PLA reaction are 
necessary in each experiment. An example of this would be the absence of the protein as the most 
stringent and appropriate negative control. This can be accomplished by siRNA or shRNA silencing of 
proteins, or utilizing cells that lack expression of the protein(s) of interest, such as cells or tissue from 
knock out animal models. Another control that may be included is using only one primary antibody in 
the reaction to provide information about non-specific antibody binding. While not ideal, pre-immune 
serum or a non-specific IgG may be paired with the antigen specific antibody. Alternatively, an antibody 
recognizing a non-interacting protein can be paired with the antibody recognizing the protein(s) of 
interest as a negative control. A positive control should also be included in the form of antibodies that 
recognize two proteins known to interact in the cells or tissues of interest. Two antibodies that 
recognize different epitopes of the same protein may be used, as well.  Sigma Aldrich also offers a PLA 
control kit consisting of mouse anti-EGFR antibody and rabbit anti-ErbB2/HER2 antibody 
(https://www.sigmaaldrich.com/catalog/product/sigma/duo92202).

Basic Protocol #1: Proximity Ligation Assay

Materials

 Cells of interest grown on coverslips (Ted Pella 15 mm no. 1 round coverslips, cat. no. 
26024 placed in 12-well culture dishes or Ted Pella 12 mm no. 1 round coverslips cat. 
no. 26023 placed in 24-well culture dishes are recommended to save on reagent), frozen 
sections from tissue specimens, or paraffin-embedded, antigen retrieved tissue sections 
on glass slides.

 Fixative of choice for 2D culture monolayers or frozen sections. Typically, 4% 
paraformaldehyde (commercially available ampules diluted to 4% using phosphate 
buffered saline (e.g. Thermo Scientific cat. no. 28908), or refer to recipe included in this 
unit).

 Detergent permeabilization buffer for recognition of cytoplasmic epitopes (if using 
paraformaldehyde for fixation (refer to recipe included in this unit, usually 0.1-0.5% 
Triton X-100.

 Primary antibodies from 2 different species and of the IgG-class (available species: 
mouse, rabbit, goat or human) or refer to Support Protocol #2 regarding making custom 
probes if the available species are not compatible with your antibody reagents.
Antibodies used in this manuscript: HECD-1 mouse anti-Ecadherin (Thermo Fisher 
Scientific, cat. no 13-1700, RRID AB_2533003), C2206 rabbit anti-β-catenin (Sigma-
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Aldrich cat. no. C2206, RRID:AB_476831), 1407 chicken anti-Plakoglobin (Aves 
Laboratories), anti-EGFR D38B1 (Cell Signaling Technology cat. no. 4267, 
RRID:AB_2246311), mouse anti-Nedd8 (Sigma-Aldrich cat. no. N2786, RRID:AB_260757), 
AB-12 mouse anti-EGFR (NeoMarkers, cat. no. MS-400-P1), FK2 mouse anti-Ubiquitin 
(Millipore cat. no. 04-263, RRID:AB_612093), goat anti-Dsg1 (R and D Systems cat.no. 
AF944, RRID:AB_2277393), 11E4 mouse anti-Plakoglobin (Millipore cat. no. MAB2083, 
RRID:AB_2127995).

 Kimwipes®  or Whatman® #1 filter paper or equivalent filter paper (e.g. Fisher Scientific 
P5 Filter paper cat. no 09-802-1A) (rip the filter paper so there is a jagged edge for 
wicking away solutions).

 Wash buffer suitable for traditional immunofluorescence using the antibody pairs 
chosen, typically phosphate buffered saline (PBS) (commercially purchased or made 
with molecular grade water, refer to recipe in this unit).

 Duolink™ In Situ Fluorescence Kit (Sigma-Aldrich, St. Louis, MO): 

Refer to the Sigma-Aldrich catalog for catalog numbers 
https://www.sigmaaldrich.com/catalog/product/sigma/duo92202

 PLA® probe MINUS, recognizing one of the antibody species in the pair 
(includes Blocking Solution and Antibody Diluent). Store at 4°C.

 PLA® probe PLUS, recognizing the 2nd antibody species of the pair 
(includes Blocking Solution and Antibody Diluent). Store at 4°C

 Optional: Custom probe(s) can be generated using the Duolink™ In Situ 
Probemaker Kit and may be used in coordination with commercial 
probes (refer to Support Protocol #2 in this unit).

 Wash Buffers A and B (powders for reconstitution available for 
purchase, or made from the recipe provided in this unit). Store 
reconstituted buffers at 4°C.

 Ligation 5× buffer (contains oligonucleotides that hybridize to the PLA® 
probes). Store at -20°C.

 Ligase 1U/µl. Store at -20°C. Keep in a freeze block when not at -20°C.
 Amplification 5× Buffer (contains components for rolling circle 

amplification and oligonucleotide probes labeled with fluorophore of 
choice that hybridizes to the amplified product). Store at -20°C in the 
dark. Keep in freeze block when not at -20°C.
  4 fluorophore options: Green (λEx 490 nm/ λEm 520 nm; FITC 

filter), Orange (λEx 542 nm/ λEm 562 nm; Cy3™ filter), Red (λEx 
593 nm/ λEm 622 nm; Texas Red® filter) or Far Red(λEx 646 nm/ 
λEm 664 nm; Cy5™ filter).

 Polymerase 10 U/µl. Store at -20°C in the dark. Keep in freeze block 
when not at -20°C.

 Duolink™ In Situ Mounting Medium with DAPI (4′,6-diamidino-2-phenylindole, nuclear 
stain) (Sigma cat. no. DUO82040). The Duolink™ mounting media does not solidify. One 
can use their own mounting media. If the mounting media does not contain DAPI incubate 
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the coverslips or slides with DAPI before the final Wash Buffer B washes at the end of the 
basic protocol (see below).

 Optional: DAPI (4′,6-diamidino-2-phenylindole) stock solution: 10 mg/ml in high purity 
water. Dilute the stock 1:5,000 in PBS for application to cells and tissues. This is not 
necessary if using the DAPI-containing mounting media supplied with the Duolink™ kit 
(see above).

 Optional: Mounting media. If one prefers to use mounting media that solidifies, there 
are a number of commercial sources that may or may not include DAPI (e.g. 
Vectashield® (Vector Laboratories cat. no. H-1500-10) or Prolong® Gold (Invitrogen cat. 
no. P36930). Sigma Aldrich warns that the PLA signal may fade more quickly when using 
different mounting media other than the Duolink In Situ Mounting Media. 

 Optional: nail polish can be used to seal the edges of the coverslip to avoid movement 
of the samples when storing, or when imaging with an immersion objective. Glitter nail 
polish adheres well to the coverglass to make a seal. Make certain the nail polish is 
hardened before imaging to avoid transfer of polish to the objective. 

Equipment

 Staining materials such as
o Hot plate (e.g. Fisher Scientific) for heating 0.1 M Citrate buffer for antigen retrieval of 

paraffin-embedded tissues (Refer to Support Protocol #1 for steps on antigen retrieval)
o Thermometer for monitoring citrate buffer and paraformaldehyde solutions
o Humidified chamber for slides or coverslips 

 Homemade humidity chambers can be made using a plastic container with a lid, 
such as a 150 mm petri dish (e.g. Sigma cat. no. P7737). Whatman® #1 filter 
paper (or equivalent filter paper) is cut to fit in the bottom of the container, wet 
with water, and overlaid with strips of parafilm. Coverslips are then placed on 
the parafilm cell side up for short term incubations or cell-side down 
sandwiching solutions between the coverslip and the parafilm for 
overnight/long term incubations.  The container or dish is sealed with parafilm 
to maintain moisture in the chamber during the incubations. For tissue slides, 
pieces of 2 ml plastic pipettes can be taped into the container or dish to lift 
slides from the floor of the chamber. In this case, water can be placed directly 
on the bottom of the dish, and filter paper is not needed. We recommend 
flipping the dish and using the lid of the container as the base, and the base of 
the container as the lid. This will provide more room for the slides when sitting 
on top of the taped plastic pipettes.

 Humidity incubation chambers for slides are available for purchase from 
multiple vendors (e.g. Sigma Aldrich, Fisher Scientific, VWR). 

o Grease pen (e.g. white one Sharpie brand, manufacturer # BERCM164T ) or PAP Pen to 
create a hydrophobic barrier around sections (e.g. ImmEdge® Hydrophobic Barrier PAP 
Pen (Vector Laboratories cat. no. H-4000), Super PAP Pen (Invitrogen cat. no. 008899) or 
ReadyProbes™ Hydrophobic Barrier Pap Pen (Invitrogen cat. no. R37622). Use caution 
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7

with pap pens, as they may interfere with the PLA reaction, or visualization of PLA signal 
when detergent in included in primary antibody diluents and/or PLA probe solutions (see 
Troubleshooting).

o Freezing block for enzymes (e.g. Thermo Scientific, cat. no. 5115-0032).
o High purity water (Millipore Milli-Q® lab water system or molecular grade water).

Protocol Steps

Do not let the coverslips or tissue sections dry out at any point during the procedure, until after the final 
wash with 0.01× Wash buffer B, directly prior to mounting to avoid background from non-specific 
reagent deposition. Use high purity/molecular grade water to prepare all solutions.  All solutions should 
be at room temperature before adding them to your coverslips or slides and all washing steps are done 
at room temperature.

Primary Antibody Incubation:

1. Fix cell monolayers or frozen tissue sections using the method that preserves antibody 
recognition of antigens of interest. Process paraffin-embedded tissues for antigen retrieval 
(refer to Support Protocol #1 for the antigen retrieval procedure).

2. Permeabilize cell monolayers, or tissue sections, as performed for traditional 
immunofluorescence. Typically, a 10 minute, room temperature incubation of cell monolayers 
with 0.2% Triton X-100 in PBS is sufficient. The blocking buffer recipe included in this unit also 
contains 1% Bovine Serum Albumin and can be used for this permeabilization step, the following 
blocking step (step 3) and as an antibody diluent (step 4). 

A grease pen or a pap pen may be used to create a hydrophobic boundary around tissue sections 
to decrease the amount of reagent used, however do not create the boundary until after this 
permeabilization step. Pap pens may be incompatible with detergents, such as Triton X-100. 
Inclusion of detergents in solutions following pap pen use may negatively affect the PLA reaction 
(e.g. hazy background, non-specific PLA signal, or reduced PLA signal). Custom blocking buffer 
without detergent, or the blocking buffer included in the PLA probe kit may be used in step 3 
below. The antibody diluent in the PLA probe kit may be used to dilute antibodies (step 4, below) 
and PLA probes (step 8, below) when using a pap pen.
 

3. Block non-specific antibody binding by increasing the time of the permeabilization incubation in 
the previous step from 10 minutes to 30 minutes at room temperature.  Alternatively, the 
blocking buffer supplied in the PLA probe kit may be used by adding it dropwise to the coverslip 
or slide.
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4. Dilute your primary antibody pairs to the appropriate dilution in the permeabilization/block 
buffer used in the previous steps 2 and 3, or use the antibody diluent supplied with the PLA 
probe kit. The amount added to each coverslip/tissue section depends on the dimension of the 
sample. 40 µl of each solution is sufficient to cover the surface of a 15 mm coverslip.

A primary antibody that is a different species than those antibodies that are used for the PLA 
reaction may be included for counterstaining, for example to indicate cell boundaries, or to 
highlight a subcellular compartment to apply spatial significance to the PLA signal. Add the 
primary antibody for counterstaining with the antibodies being used in the PLA reaction.

5. Tap off the blocking buffer by touching the edge of the coverslip or slide against a piece of filter 
paper or a Kimwipe® and replace it with the diluted antibodies. Keep the amount of residual 
blocking buffer left on the sample and the amount of primary antibody added the same among 
the coverslips or slides to maintain consistency among samples. 

6. Incubate the coverslips or slides with primary antibody in a humid chamber sealed with parafilm 
using temperatures and times that are optimal for the antibody pairs, such as 1-2 hours at 37°C, 
or overnight at 4°C. 

The PLA procedure contains multiple extended incubation steps. Allowing the primary antibodies 
to bind overnight at 4°C is a convenient step at which to pause the protocol. For overnight 
incubation, add the antibody on the coverslip and flip it over with the solution cell-side down on 
to the parafilm, sandwiching the antibody between the coverslip and the parafilm to ensure that 
the samples do not dry out during the extended incubation time. In the case of tissue sections, 
make sure that enough water is present in the humid chamber during the overnight incubation.  

PLA® Probe Incubation:

7. Bring the coverslips or slides that have been incubating in primary antibodies at 4°C or 37°C in 
step 6 to room temperature. 

8. Mix the two PLA® probes (PLUS and MINUS commercial stocks, or custom made probe(s), refer 
to Support Protocol #2 in this unit for details), and dilute 1:5 in the same buffer used for diluting 
the primary antibodies, or the antibody diluent provided  in the PLA probe kit. Prepare enough 
of the mix to cover the sample without it dyring out during the incubation time (e.g. for 15 mm 
round coverslips a 40 µl reaction is appropriate; use 8 µl of each probe and 24 µl of the antibody 
dilution buffer). Let this cocktail sit for 20 minutes at room temperature before adding to the 
coverslips or slides.  

Custom probe kits can be purchased for the generation of PLUS or MINUS probes and the 
generated probes can be paired with standard, commercial probes at this step.
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9. Tap off the primary antibody by touching the edge of the coverslip or slide against a piece of 
filter paper or a Kimwipe® and wash two times with 1× Wash Buffer A, incubating 5 minutes 
each (recipe included in this unit). Washing steps can be performed by pipetting and aspirating 
Wash Buffer A while flat in the humid chamber. If desired, staining jars or dishes may be used for 
tissue sections and can be placed on an orbital shaker for gentle shaking during the wash step to 
enhance the effectiveness of the washing steps. 

At this step and all the following steps, cells on coverslips can be placed in the humid chamber 
cell-side up.

10. Tap off the 1× Wash Buffer A by touching the edge of the coverslip or slide against a piece of 
filter paper or a Kimwipe® and immediately add the diluted PLA probe mixture made in step 8, 
above. Incubate coverslips or slides in a humid chamber at 37°C for 1 hour.  

Keep the amount of residual wash buffer and the amount of probe cocktail the same among 
samples to maintain consistency. 

Ligase Incubation:

11. Bring the coverslips or slides that have been incubating with the PLA probes at 37°C in step 10 to 
room temperature.

12. Tap off the PLA probe solution by touching the edge of the coverslip or slide against a piece of 
filter paper or a Kimwipe® and wash the coverslips or slides two times in 1× Wash Buffer A, 
incubating for 5 minutes each.

13. During the washes, dilute the Ligation Stock Buffer (5×) 1:5 in high purity water.  After the final 
wash is complete, add the Ligase at a dilution of 1:40 to the diluted ligation buffer (e.g. for a 40 
µl volume, add 8 µl 5× Ligase buffer to 31 µl high purity water and 1 µl Ligase enzyme).   Keep 
the Ligase in a freeze block. 

14. Tap off the 1× Wash Buffer A by touching the edge of the coverslip or slide against a piece of 
filter paper or a Kimwipe® and add the diluted Ligase solution from the previous step to the 
coverslips or slides.

15. Incubate the coverslips or slides at 37°C for 30 minutes in the humid chamber.

Amplification Incubation:

16. Bring the coverslips or slides that have been incubating with the ligase solution at 37°C in step 
15 to room temperature.

17. Tap the Ligase solution by touching the coverslip or slide against a piece of filter paper or a 
Kimwipe® and wash 2 times with 1× Wash Buffer A, incubating for 2 minutes each. 
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18. During the washes, dilute the Amplification Stock Buffer (5×) 1:5 in high purity water.  After the 
final wash is complete, add the Polymerase enzyme at a dilution of 1:80 to the diluted 
amplification buffer (e.g. for a 40 µl volume, add 8 µl 5× Amplification buffer to 31.5 µl high 
purity water and 0.5 µl Polymerase enzyme).   Keep the Polymerase in a freeze block.

 
19. Make certain to remove as much of the 1× Wash Buffer A from the coverslips or slides as 

possible by wicking it away with filter paper or a Kimwipe® before adding the 
Amplification/Polymerase solution from the previous step. 

20. Incubate the coverslips or slides in the humid chamber at 37°C for 100 minutes.

The Amplification stock contains light sensitive reagents, so at this step and moving forward take 
care to protect the samples from light by using a dark humid chamber, or covering the chamber 
with tin foil to prevent fading of the fluorophores.

Increasing the amount of time at the amplification step can increase the amount of PLA signal, 
but it can increase non-specific background, or cause the coalescence of PLA spots, limiting the 
type of quantification that can be done to determine the amount of PLA signal per field of view.

 Washing and Mounting the slides:

21. Bring the coverslips or slides that have been incubating in the amplification solution at 37°C in 
step 20 to room temperature.

22. Tap the Amplification/Polymerase solution from the coverslips or slides by touching the 
coverslip or slide against a piece of filter paper or a Kimwipe®.

23. Wash the coverslips or slides 2 times with 1× Wash Buffer B, incubating for 10 minutes each 
time.  

If a primary antibody was added for counterstaining in step 4, wash samples in 1× Wash Buffer A 
for 1 min following step 23. Add secondary antibody and incubate the coverslips or slides for 30 
min at 37°C in the humid chamber. Tap off the antibody solution by touching the edge of the 
coverslip or slide against a piece of filter paper or a Kimwipe®. Wash coverslips or slides 2 times 
with 1× Wash Buffer A for 2 min before proceeding to step 24. 

If the mounting medium does not contain DAPI, incubate the coverslips or slides for 2 minutes 
with 1 µg/ml DAPI at room temperature. Wash coverslips or slides 3 times with 1× Wash Buffer B 
for 2 min before proceeding to step 24. DAPI can be useful for quantification of the PLA signal 
when plotting PLA signal as PLA signal area/image, PLA signal area/cell or the number of PLA 
spots/cell within the field of view.
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24. Wash the coverslips or slides one time with 0.01× Wash Buffer B, incubating for 1 minute.

25. Tap off the 0.01× Wash Buffer B by touching the edge of the coverslip or slide against a piece of 
filter paper or a Kimwipe® and allow the samples to air dry completely before mounting. 

Completely air drying the sample at this stage is important for optimal PLA signal.

26. Mount the coverslips or slides with a minimal amount of mounting medium using either 
Duolink™ In Situ Mounting Medium with DAPI, or another mounting medium (e.g. for a 15 mm 
coverslip 10-20 µl of mounting medium is appropriate). Excess mounting medium that leaks 
from underneath can be carefully suctioned off using a pipette or by vacuum, or by placing a 
Kimwipe® on top of the coverslip to wick away the excess.  Slides can be stored flat and in the 
dark at 4°C for several days without significant loss of signal.  

Duolink™ In Situ Mounting Medium with DAPI will not solidify. Before mounting, use a Kimwipe®, 
filter paper, or a cotton swab soaked with water to carefully remove salt and debris from the 
non-cell side of the coverslip. Attempts to clean the surface after mounting will result in 
movement of the coverslip. Store slides flat to avoid coverslip movement.  Applying nail polish 
around the coverslip edge, or using solidifying mounting media can decrease the amount of 
coverslip movement, allowing for imaging with high power immersion lenses. Use of a different 
mounting media may result in the PLA signal fading more quickly than when using the 
recommended reagent.

27. Refer to the subsequent Basic Protocol #2 for Imaging, Quantification and Analysis of PLA 
signals.

Support Protocol #1: Antigen retrieval method for formalin fixed paraffin-embedded tissues

Formalin fixation cross-links protein, making antigens inaccessible to antibodies. The antigen retrieval 
protocol combines high temperature with buffers at low pH to unmask antigenic determinants.

Materials

 4-5 µm Sections on Superfrost Plus slides (VWR cat. no. 48311-703) from tissues fixed 
with 10% (v/v) neutral buffered formalin and embedded in paraffin. Tissue processing 
and sectioning are standard procedures and usually performed in a dedicated histology 
laboratory.

 Staining dishes with slide racks or Coplin jars containing
o Xylene 
o 100% ethanol 
o 70% ethanol
o PBS 

1. Bake slides at 60oC, overnight to melt paraffin and dry the tissue.
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2. Place slides in a staining dish containing xylene for 3 minutes, repeat twice with fresh xylene.

3. Dehydrate the tissues by transferring the slides to a staining dish containing 100% ethanol for 3 
minutes, repeat twice with fresh 100% ethanol.

4. Transfer the slides to a staining dish containing 70% ethanol and incubate 3 minutes.

5. Transfer the slides to a staining dish containing PBS and incubate 3 minutes, repeat twice with 
fresh PBS.

6. Transfer the slides to a staining dish containing PBS and incubate 3 minutes.

The solutions should be replaced after processing ~50 slides, or at least every 2 weeks. 

7. Permeabilize the tissue sections by incubating in 0.5% Triton X-100 in PBS for 10 minutes.

8. Incubate the slides in 0.01 M Citrate buffer (pH 6.0) at 95oC for 15 minutes. This can be done by 
placing the slides in a dish on a hot plate. Monitor the temperature with a thermometer. Do not 
allow the citrate buffer to come to a boil.

9. Remove the dish from the hot plate and allow the citrate buffer to cool to room temperature. 

10. Wash the slides by placing them in a staining jar containing PBS and incubating for 3 minutes at 
room temperature; repeat two more times with fresh PBS.

11. Continue with the PLA protocol detailed in Basic Protocol #1, step 3, blocking non-specific 
antibody binding.

A grease pen or PAP Pen can be used to create a hydrophobic barrier around sections. Use 
caution with pap pens, as they may interfere with the PLA reaction, or visualization of PLA 
signal when detergent in included in primary antibody diluents and/or PLA probe solutions (see 
Troubleshooting).

Support Protocol #2:  Creating custom PLA probes using the Duolink™ In Situ Probemaker Kit when 
commercially available probes are not suitable 

Custom probe kits can be purchased for the generation of PLUS or MINUS probes and the generated 
probes can be paired with standard, commercial probes.

Create unique probes in the event that the commercially available kits will not suffice, such as

o When the 2 antibodies for pair recognition are from the same species.
o When the antibody species you have is not one of the commercially available reagents 

(mouse, rabbit, goat or human). 
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o When visualizing a homodimer. The same antibody can be labeled with each probe (Plus 
and Minus) (Ota et al., 2017). 

o When using antibodies derived from the same species as the tissue sample, such as 
mouse antibodies to stain mouse tissue. This eliminates the need to use anti-mouse 
secondary antibodies that may cause high background in traditional 
immunohistochemistry from recognition of endogenous mouse IgG.

o Note: Certain antibody specifications must be met:
 The antibody concentration must be at 1 mg/ml or greater.
 20 µl volumes should be used for conjugation of the probe. Concentrating dilute 

antibodies is not recommended.
 The antibody must be in an amine, carrier and preservative free buffer, but may 

contain up to 0.1% BSA, 5% trehalose, and 0.02% sodium azide. 
 If a monoclonal antibody is used, it should be Protein A or Protein G affinity 

purified.

Materials

 Antibody to be labeled with the Duolink™ Probemaker kit
 Duolink™ PLA Probemaker kit (Probemaker PLUS: 

https://www.sigmaaldrich.com/catalog/product/sigma/duo92009 ; Probemaker MINUS: 
https://www.sigmaaldrich.com/catalog/product/sigma/duo92010)

 Duolink™ PLA lyophilized PLUS or MINUS oligonucleotides 

 Conjugation Buffer

 Stop Reagent

 Storage Solution 

 20× Assay Reagent 

 Blocking Solution 

 PLA Probe Diluent. This should be used in substitution of the Duolink™ Antibody 
Diluent found in the basic kit. 

Store all reagents at -20°C. Once the antibody is conjugated, store at 4°C.

 

Protocol steps

1. Add 2 µL of Conjugation Buffer to 20 µL of the antibody and pipette gently to mix. The antibody 
concentration should be 1 mg/ml.

2. Open a vial of lyophilized oligonucleotides and immediately add the above antibody solution. 
Pipette gently to mix. 

3. Incubate at room temperature overnight.
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4. The next day add 2 µL of Stop Reagent to the reaction. Pipette gently to mix.

5. Incubate at room temperature for 30 minutes.

6. Add 24 µL of Storage Solution to the stopped reaction. Pipette gently to mix.

7. The PLA probe(s) may be used immediately, or stored at 4°C. They can be paired with a 
commercial PLA probe in Basic Protocol #1.

Basic Protocol #2: Imaging, quantification and analysis of PLA signals

Images can be quantified using a variety of analysis software packages, such as ImageJ/FIJI. Data may be 
presented as number of PLA spots observed per field or the number of PLA spots observed/number of 
cells in the field, but PLA signals may coalesce, resulting in under sampling. Consequently, when a strong 
interaction is observed, present data as the area of PLA signal per field (not signal intensity) or the area 
of PLA signal per field/number of cells.

Quantification can be plotted as (1) the number of spots per field, (2) the number of 
spots/number of cells within the field as determined by DAPI counterstaining, (3) area of PLA 
signal per field, or (4) by area of PLA signal per field/number of cells.

Materials and Equipment:

 Widefield or confocal fluorescence microscope equipped with excitation and emission filters 
that are compatible with the fluorophore and nuclear stain from the chosen kit, air objectives 
(e.g. 20× (NA 0.4), 20× (NA 0.8), or 40× (NA 0.7)) and software for image acquisition. If using a 
solidifying mounting medium, or sealing the coverslip with nail polish, then a high NA immersion 
objective (e.g. 63× (NA 1.4)) can be used to yield higher quality PLA images.

 Program to obtain objective quantification of PLA fluorescence signals (e.g. Image J/FIJI, NIH, 
http://imagej.nih.gov/ij). 

 Programs such as Microsoft® Excel or GraphPad Prism® used to graph the data from the 
analysis.

Imaging

1. Imaging with a widefield fluorescence or confocal microscope can be done using a 20× or 40× air 
objective as early as 15 minutes after mounting. If using a solidifying mounting medium, or 
sealing the coverslip with nail polish, a high NA immersion objective (e.g. 63×, NA 1.4) can be 
used to yield higher quality PLA images the day after mounting.
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Any of the mounting media that has leaked from underneath the coverslip may make it difficult 
to form a seal, so careful handling and flat storage of the samples must be performed after the 
application of polish. Excess mounting media can be removed by suctioning off with a vacuum or 
a pipette. Note that Sigma Aldrich recommends use of the Duolink In Situ mounting media as use 
of a different mounting media may result in the PLA signal fading more quickly than when using 
the recommended reagent.

Imaging a single focal plane is usually sufficient to analyze the PLA signal for cell monolayers and 
may be sufficient for thin >5 um tissue sections. For thicker samples, such as multilayer cell 
cultures or tissue sections, it is advisable to perform confocal imaging with a high NA immersion 
objective, capturing multiple z-planes and merging them into a maximum intensity projection. 
Using high NA immersion objectives will  enhance the resolution of high-density PLA signals to 
resolve coalesced PLA dots observed in lower NA objectives, enhancing the accuracy of the 
number of PLA dots quantified. Alternatively, quantifying the signal area can bypass the need for 
high NA immersion objectives when using a lower NA air objective. 

2. Collect images of the PLA signal first to avoid bleaching, followed by the channel used for 
counterstain, if applicable, and the image of the DAPI channel. 

Apply the same acquisition parameters (camera settings and exposure times) between samples 
when collecting PLA signal images. It is best to use the strongest stained sample (usually the 
positive control) when setting camera settings and exposure times to prevent image saturation. 
PLA results can vary from experiment to experiment; therefore, collect data from positive and 
negative controls for each experiment.

Quantification using ImageJ/FIJI

Quantification can be plotted as (1) the number of spots per field, (2) the number of 
spots/number of cells within the field as determined by DAPI counterstaining, (3) area of PLA 
signal per field, or (4) by area of PLA signal per field/number of cells. 

3. Choose an Auto Threshold method for the PLA signal: Image>Adjust>Auto Threshold>Try all and 
choose a preferred auto-threshold method. Threshold with the preferred method: 
Image>Adjust>Threshold>click the down arrow to change Default to the chosen method>Apply 
(makes binary image to use for the watershed function, if measure the PLA signal area then you 
do not need to click “Apply”). Keep auto-threshold method consistent between experimental 
groups.

Alternatively, if the samples are processed and the imaged the same, then you can use a fixed 
threshold by setting the Min and Max threshold and keeping this threshold limit consistent 
between experimental arms. However, auto-thresholding is recommended to enhance 
reproducibility. 

4. Go to Analyze>Set Measurements and make sure Area and Limit to threshold is checked.
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5. To measure PLA signal area: Analyze>Measure. The area of PLA signal will be in the area column 
of the resulting table (you do not want the mean, which is the signal intensity).

Alternatively, the number of PLA dots can be quantified using ImageJ/Fiji by segmenting 
coalescing signals using Process>Binary>Watershed and counting the number of dots using 
Analyze>Analyze Particles. This method is only advisable if the dots are well separated in the 
image in all conditions.  Particles that are closer than the resolution limit of the objective lens will 
coalesce, not allowing one to distinguish individual protein-protein interactions. The resolution 
can be calculated by the formula 0.61 * λ / NA where λ is the wavelength and NA is the 
numerical aperture of the objective used to image the sample. If the dots are dense in the 
images and may comprise multiple spots it is recommended that average intensity/area be used 
for quantification. 

6. To manually count the number of DAPI positive nuclei: Plugins>Analyze>Cell Counter>Cell 
Counter. Click Initialize under Actions and Type 1 under Counters. To count the DAPI nuclei click 
on each cell nuclei on your Counter Window image. 

Alternatively, if you do not have multinucleated cells, you can automize the number of DAPI 
nuclei similar to quantifying the number of PLA dots: by segmenting overlapping nuclei using 
Process>Binary>Watershed and counting the number of DAPI positive cells using 
Analyze>Analyze Particles.

7. In Microsoft® Excel, divide the PLA signal area to the number of DAPI positive nuclei to get the 
amount of PLA signal area/DAPI positive nuclei. Calculate the Average PLA signal 
area/image/image/image or PLA signal area/number of cells for each independent experiment.

8. Graph your data along with relevant controls using programs such as Microsoft® Excel or 
GraphPad Prism®  and perform statistical analysis tests, such as t-test (experiments with two 
experimental arms) or one-way ANOVA with an appropriate Post hoc Test (experiments with 
more than two experimental arms).

Reagents and Solutions—all solutions are made with high quality water 

4′,6-diamidine-2′-phenylindole dihydrochloride (DAPI) 
Stock solution: 1 mg/ml diluted in water

 May need to sonicate, or put at 65°C to completely dissolve powder. Alternatively, 
dimethylformamide (DMF) can be used in place of water for stock solution.

 Store stocks at -20°C in the dark

Working solution: 1 µg/ml in 1× Wash buffer B or PBS
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 Dilute stock solution 1:1,000 in 1× Wash Buffer B or PBS. 
 Incubate samples for 2 minutes at room temperature.
 Wash 3 times with 1× Wash buffer B.
 Make from stock solution when ready to use

4% Paraformaldehyde
Paraformaldehyde 0.8 g 
H2O qs to 10 ml
10 N NaOH dropwise
0.2M NaPO4 buffer 10 ml

 Use caution when working with the paraformaldehyde and do all work from dispensing 
the power, heating the solution and fixing the cells under a fume hood to avoid 
inhalation.

 Heat the 0.8 g paraformaldehyde in 10 ml water and heat to 65°C on a hot plate while 
stirring gently. Do not let the temperature of the solution exceed 65°C.

 Add 10 N NaOH dropwise to the heated solution slowly during a 5-10 minute period to 
get all of the paraformaldehyde powder into solution.

 Add 10 ml 0.2 M Sodium Phosphate buffer, pH 7.4 (refer to above recipe)
 Let cool to room temperature before using the solution to fix cells or tissue sections.
 Best made fresh, though aliquots can be stored for several days at 4°C or for several 

months at -20°C.

Detergent Permeabilization/Blocking Buffer 
0.2% Triton X-100 
1% Bovine Serum Albumin 
Dilute in PBS

 Filter sterilize and store stocks at 4°C for several months

Duolink™ Wash Buffers (A and B)
**Pouches containing the chemicals are available for purchase from Sigma Aldrich. Recipes are included 
below:

In Situ Wash Buffer A—pH 7.4
NaCl 8.8 g
Tris Base 1.2 g
Tween 20 500 µl
H2O 800 ml
HCl to pH to 7.4
H2O qs to 1 L

 Filter sterilize and store stocks at 4°C

In Situ Wash Buffer B—pH 7.5
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NaCl 5.84 g
Tris Base 4.24 g
Tris-HCl  26 g
H2O 500 ml
HCl to pH to 7.5
H2O qs to 1 L 

 Filter sterilize and store stocks at 4°C

Phosphate Buffered Saline (PBS) 1 Liter
NaCl 8 g
KCl 0.2 g
Na2HPO4·7H2O 2.17 g
KH2PO4 0.2 g
H2O qs to 1 L

 Store stock at room temperature

Sodium Citrate Buffer

0.1 M sodium citrate (Sigma-Aldrich)
pH 6.0
 Make fresh at the time of use

0.2 M Sodium Phosphate Buffer pH7.4
NaH2PO4 (monobasic) 0.53 g
Na2HPO4 (dibasic) 4.34 g
H2O qs to 100 ml
pH to 7.4

 Store stock at room temperature

Alternatively, combine monobasic and a dibasic Sodium Phosphate stocks (recipes below) to 
obtain the desired pH of 7.4. Mix 19 ml of the monobasic stock solution below with 81 ml of the 
dibasic stock solution below to obtain a sodium phosphate solution with a pH of 7.4.

NaH2PO4 (monobasic) Stock Solution
27.6 g monobasic monohydrate 
qs to 1 Liter with water

 Store stock at room temperature

Na2HPO4 (dibasic) Stock Solution
28.4 g dibasic 
qs to 1 L with water

 Store stock at room temperature
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COMMENTARY

Background Information

The Proximity Ligation Assay (PLA) was first designed using DNA aptamers that recognized target 
proteins. The aptamers contain extended sequences that recognized an additional connecting 
oligonucleotide. If in close enough proximity, the two aptamers would ligate together. This ligated 
sequence served as a template for PCR resulting in amplification that could be quantified (Fredriksson et 
al., 2002).  The method was then modified by attaching oligonucleotides to primary antibodies, making 
use of available antibody reagents instead of designing target sequences for each experiment (Gullberg 
et al., 2004).  Further modifications of the technique included the application of rolling circle 
amplification, which enhanced the signals and allowed for in situ visualization of low frequency events 
(Söderberg et al., 2006). The technique has become more widely utilized since the assay was redesigned 
to link oligonucleotides to secondary antibodies and made commercially available in 2007 by Olink 
Bioscience along with standardized ligation and amplification conditions (Figure 1).  The Duolink™ 
technology designed and marketed by Olink® (https://www.olink.com/about-us-olink-biomarker-
discovery/#) was recently sold to Sigma-Aldrich in 2015 
(https://www.genengnews.com/topics/bioprocessing/sigma-aldrich-buys-duolink-portfolio-from-olink/). 
Recently, a variation of the PLA technique was developed to enhance the efficiency and sensitivity of the 
assay, but is not yet commercially available (Klaesson et al., 2018). PLA has also been adapted to 
accommodate high-throughput imaging to observe large-scale changes in protein interactomes and to 
test the efficacy of individual compounds from small molecule libraries (Mendez & Banerjee, 2017).

Biochemical methods provide information about protein-protein interactions in cells, and the use of 
biosensors utilizing fluorescent proteins can bring in the added information of the subcellular 
localization of protein-protein interactions (Sam Duwé & Dedecker, 2019). Likewise, PLA reveals protein 
interactions in situ, but the standardized protocol relieves the difficulties associated with the design of 
fluorescent constructs and opens up the ability to look at endogenous proteins (Figures 2-5).  This is 
particularly useful in cases where material is limited and/or genetic manipulation is not possible, such as 
when working with clinical samples (Figure 5). The use of PLA in mouse, Drosophila, and human/clinical 
tissue has been applied to multiple studies to investigate protein-protein interactions including the 
following references (Bagchi, Fredriksson, & Wallén-Mackenzie, 2015; Doebele et al., 2015; Harmon et 
al., 2013; Mannix, Starble, Kaufman, & Cooley, 2019; Mendez & Banerjee, 2017; Ruffmann et al., 2018; 
Sartori et al., 2019; Taura, Fernández-Dueñas, & Ciruela, 2015). By combining antigen detection via 
antibody with PCR amplification, interactions that would otherwise be difficult to detect are able to be 
visualized and quantified while eliminating background signals.  Thus, PLA can be used to detect single 
proteins that have low levels of endogenous expression and visualize rare protein-protein interactions 
within a cell and has been used to detect an interaction of two different proteins expressed on different 
cell types (Sable et al., 2018). This technique can also be applied for the detection of post-translational 
protein modifications (Figure 3). The versatility of PLA makes this a useful technique for the cell biology 
laboratory. 
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Critical Parameters

To ensure success, the antibodies for the assay must be carefully chosen and the parameters that result 
in optimal antibody binding should be determined prior to applying the PLA technique. These 
parameters include antibody concentration/dilution, the fixation/permeabilization conditions that allow 
for optimal epitope recognition and blocking conditions to minimalize background/non-specific staining. 
To be able to utilize the Duolink™ pre-made probes the antibody pairs must also be from two different 
species and of the IgG class generated in mouse, rabbit, goat or human.  A Probemaker kit is available 
with which probes can be generated using primary antibodies of different species or of the same species 
as long as certain specifications for those antibodies are met (refer to Support Protocol #1). 

Positive and negative controls are important considerations for the assay.  Positive controls include 
traditional immunofluorescence with the antibodies used in the PLA to demonstrate successful antibody 
recognition, as well as including a well-vetted PLA pairing that works in the cell type being analyzed that 
is run in parallel (Figure 2). As a negative control, it is most desirable to silence each protein of the pair 
in turn to determine the level-of background signals. Traditional immunofluorescence and western 
blotting should be included to demonstrate that silencing was successful.  If silencing is not possible, 
pre-immune serum for each antibody or non-specific IgG from the same species can be used. However, 
non-specific IgG can be problematic, as the concentration of the specific antibodies used are not known 
and thus one is unable to add the comparable amount of non-specific IgG to the control sample.  In the 
case of clinical specimens, control tissues are important for determining background PLA signal and if 
possible should be collected from the same body region and processed at the same time as the patient 
material. Analyzing non-lesional and lesional areas from the same patient is the ideal situation to 
observe differences in the affected areas; however, if that is not an option it is beneficial to validate 
results using in vitro models when possible.

For clinical specimens, when material is often limiting, analysis should be performed on at least 3 
separate sections, if possible from separate patient biopsies, collecting intensity measurements at 5 
regions across each tissue section. For cell monolayer experiments, a population analysis of three 
independent biological repeats should be performed, collecting intensity measurements from 5-10 areas 
across the coverslip to survey 25-50 cells per experimental arm. A population analysis and biological 
repeats are necessary to control for the amount of variation that can be observed among imaged areas 
of the same sample as well as the variation observed between biological repeats. An example of the 
variation that can be observed in a single experiment is shown in the quantification of Figures 2C (cell 
monolayers), 4B (3D organotypic cultures), and 5C, where each data point in the graph indicates the 
area of PLA signal per field/number of cells in a region of a coverslip (Figure 2C), or area of PLA signal per 
field in the tissue sections (Figure 4B, 5C). In these figures the error bars represent the standard 
deviation of the data. 

Troubleshooting

Sigma-Aldrich has an appendix containing general troubleshooting guidelines in the user guide for 
Duolink™ In Situ Fluorescence (https://www.sigmaaldrich.com/technical-
documents/protocols/biology/duolink-troubleshooting-guide.html). In general, the most commonly 
experienced problems are the inability to detect any signal, very weak signals barely above background, 
or the presence of significant non-specific PLA signal. Some tissues and cells may exhibit 
autofluorescence in the green channel, thus the Green detection reagent should be avoided in such 
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instances (λEx 495nm/ λEm 527nm). Optimization of the antibody recognition of the proteins in the PLA 
pairing via traditional immunofluorescence methods will increase specific PLA signal. Furthermore, one 
must ensure that there is very little residual wash buffer left on the slides to prevent the ligation and 
amplification solutions from unwanted dilution. Incubations at 37°C and adherence to the 
manufacturer’s recommended incubation times (1 hour for the probe incubation, 30 minutes for ligation 
and 100 minutes for the amplification) are also important for maximizing PLA signal.  Non-specific PLA 
signal can result from insufficient blocking to inhibit non-specific antibody binding or antibody 
concentrations that are too high. Another common reason for non-specific PLA signal deposition is 
drying out of the sample during one or more steps of the procedure before the final 0.01x Wash Buffer B 
step (Step 25). Incubations should be performed in a humid chamber and solutions should be of 
sufficient volume to cover the specimen without evaporation during the incubation times. The edges of 
the coverslip are most apt to dry out during incubations, resulting in the formation of salt crystals and 
higher PLA signals. Therefore, the investigator should avoid coverslip edges when collecting images. The 
coverslips or tissue samples are dried ONLY at the end of the PLA procedure directly prior to mounting 
after a final wash with 0.01x Wash Buffer B to avoid the deposition of salt crystals. The use of de-ionized 
water or lower purity water may result in a decrease of PLA signals, so high purity water is important 
when making solutions. For PLA performed on tissue sections where a pap pen is used to create a 
hydrophobic circle around the tissues, detergent should not be present in the blocking buffer, and the 
antibody and PLA probe diluent to avoid weak or non-specific PLA signal and high background signal. 
Alternatively, a grease pen can be used to create the hydrophobic barrier.

Anticipated Results

Figures 2-5 illustrate examples of expected results when performing PLA to look at protein-protein 
interactions and post translational modifications in 2D and 3D culture models, as well as in clinical 
specimens. Figure 2 demonstrates results of PLA in 2D epithelial monolayers to analyze protein-protein 
interactions.  Antibodies recognizing E-cadherin and β catenin, two components of the cell-cell adhesive 
junction, the adherens junction, reveal the proximity between two proteins that are known to interact 
directly biochemically. An antibody against another cell-cell junction associated protein, plakoglobin, is 
used as a counterstain to demarcate cell membranes and attribute spatial relevance to the PLA 
signature. Refer to Rüsbaum et al for a review on cell-cell junctions (Rübsam et al., 2018).   In Figure 3, 
the ability of PLA to reveal post-translational modifications of Epidermal Growth Factor Receptor (EGFR) 
are presented. An antibody recognizing EGFR is used in combination with an antibody recognizing 
Ubiquitin or Nedd8, a ubiquitin-like protein (Najor et al., 2017).  In this experiment, the authors’ 
questioned whether Nedd8 and Ubiquitin could compete for lysine residues on EGFR. Through the loss 
of a de-neddylating mechanism (siCOPS3), the authors noted that EGFR displayed a lower EGFR-
ubiquitin PLA signal when compared to control, suggesting that Nedd8 moieties were potentially 
blocking Ubiquitin moieties. In Figure 4 and 5, antibodies recognizing Desmoglein 1 and Plakoglobin, two 
components of the cell-cell adhesive junction, the desmosome, are used to demonstrate the interaction 
between these two proteins and attribute a spatial signature to the interaction within a 3-dimensional 
organotypic culture model of human skin and in clinical biopsies. In Figure 4, paraffin-embedded 
sections of 3D organotypic cultures mimicking the epidermal layers of human skin are used to 
demonstrate the utility of PLA in sections. This epidermal organotypic culture is grown on an air-liquid 
interface and is a powerful model for understanding human skin function. They can be generated using 
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primary keratinocytes isolated from human foreskin, or biopsy material and by keratinocytes derived 
from iPS cells. Refer to Arnette et al for a protocol on how to culture these 3 D models (Arnette, 
Koetsier, Hoover, Getsios, & Green, 2016). In the example in Figure 5, the patient biopsy was obtained 
from an individual afflicted with Severe dermatitis, multiple Allergies and Metabolic wasting (SAM) 
syndrome, a skin disease associated with a loss of Desmoglein 1 expression at the cell-cell adhesive 
interface (Dsg1 p.R887X), and this loss is quantifiable using the PLA assay (Eran Cohen-Barak et al., 2020; 
Samuelov et al., 2013).

Time Considerations

The Duolink™ procedure contains a number of long incubation steps; therefore, it is recommended that 
the protocol be carried out over 2 days. The slides are best imaged within the first few days of the 
completion of the protocol and can be imaged as early as 15 minutes after mounting, when using a non-
solidifying mounting media. Store the slides flat and in the dark at 4°C or -20°C until imaging. 
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 Internet Resources

https://www.olink.com/about-us-olink-biomarker-discovery/#

Website of Olink, the first marketers of the PLA procedure.

https://www.genengnews.com/topics/bioprocessing/sigma-aldrich-buys-duolink-portfolio-from-olink/) 

Website describing the purchase of the Duolink® Product Portfolio

https://www.sigmaaldrich.com/life-science/cell-biology/antibodies/duolink-and-pla-
technology/resource-center.html

Website for the Sigma Aldrich resource center for PLA, including assay optimization information, a 
product selection guide and a link to troubleshooting tips and FAQs.

https://www.sigmaaldrich.com/technical-documents/protocols/biology/duolink-troubleshooting-
guide.html

Website for the Sigma Aldrich PLA troubleshooting guide

https://www.sigmaaldrich.com/catalog/product/sigma/duo92202

Website for the product catalog of Sigma Aldrich PLA kits and components.

Figure Legends

Figure 1. Schematic presenting the principal of the Proximity Ligation Assay® (PLA) for the detection of 
two proteins within a proximity of ≤ 40nm. (1) Two antibodies of different species are selected that 
recognize two proteins of interest. (2) Secondary antibodies that recognize the Fc regions of the primary 
antibody species are conjugated with oligonucleotide probes and then incubated with the sample. (3) 
Ligase and free oligonucleotides that hybridize with the probes bring the oligonucleotides together in a 
closed circle confirmation if the proteins are in close enough proximity. (4) Finally, polymerase is added 
to the reaction to allow for rolling circle amplification, while fluorescently labeled oligonucleotides 
hybridize with the rolling circle product resulting in the accumulation of a fluorescent spot in areas of 
successful amplification. 

Figure 2. PLA applied to cell monolayers demonstrating protein-protein interactions in situ. Antibodies 
recognizing components of the cell-cell adhesive junction, the adherens junction, are used here to 
demonstrate the ability to visualize proximity between two proteins and attribute a spatial signature to 
the interaction within the 2-dimensional cell monolayer.  For a review on the cell-cell junctions, the 
desmosome and the adherens junction refer to Rübsam et al (Rübsam et al., 2018). A. The 

Page 51 of 57

John Wiley & Sons

Current Protocols

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40
41
42
43
44
45
46
47
48
49
50
51
52
53
54
55
56
57
58
59
60

https://www.olink.com/about-us-olink-biomarker-discovery/
https://www.genengnews.com/topics/bioprocessing/sigma-aldrich-buys-duolink-portfolio-from-olink/
https://www.sigmaaldrich.com/life-science/cell-biology/antibodies/duolink-and-pla-technology/resource-center.html
https://www.sigmaaldrich.com/life-science/cell-biology/antibodies/duolink-and-pla-technology/resource-center.html
https://www.sigmaaldrich.com/technical-documents/protocols/biology/duolink-troubleshooting-guide.html
https://www.sigmaaldrich.com/technical-documents/protocols/biology/duolink-troubleshooting-guide.html


25

transmembrane protein, E-cadherin (antibody: HECD-1 mouse) and its cytoplasmic binding partner β-
Catenin (antibody: C2206rabbit) demonstrated the use of PLA to reveal protein-protein interactions in situ, 
visualized by PLA reaction “spots” shown in red (Duolink™ In Situ Detection Reagent Red, λEx: 594, λEm: 
624).  Plakoglobin  (antibody: 1407chicken, white), a constituent of the adherens junction and its related 
cell-cell junction, the desmosome, is used as an immunofluorescent counterstain to reveal the location 
of cell-cell borders in the monolayer to give spatial relevance to the location of the PLA reaction. DAPI 
labels nuclei in blue.  Controls for the assay include combining each primary antibody with pre-immune 
sera of the opposite species used (anti-E-cadherinmouse paired with IgGrabbit (rbIgG) and β-Cateninrabbit 
paired with IgGmouse (mIgG)). A highly recommended control is the silencing of the proteins of interest. 
Note the decreased PLA signal in the siRNA silenced samples in A (siβ-Catenin, siE-Cadherin). B. 
Traditional immunofluorescence (IF) using the antibodies at the same concentrations as used in the PLA 
reaction is performed to demonstrate successful antibody binding and to observe the effect of E-
cadherin and  β-Catenin silencing (E-cadherin or β-Catenin, white; DAPI, blue).  C. Quantification of PLA 
signal. Data points in the graph indicate the area of PLA signal per field/number of cells in the field. DAPI 
was used to determine cell number. Error bars indicate the standard deviation. ImageJ/FIJI was used for 
image analysis and data graphed using GraphPad Prism®. D. Western blot analysis was done in parallel 
to assess the efficiency of siRNA-mediated knockdown for each protein. Note that the knockdown of E-
Cadherin resulted in a decrease in β-Catenin levels, reflected in the slightly lower amount of PLA signal 
observed in the siE-Cadherin condition. PLA images were acquired using a DMR Leica microscope with a 
40X (PL Fluortar, NA 0.7) using a Hamamatsu Orca 100 CCD camera model C4742-95. Traditional 
immunofluorescence images were acquired using an AxioVison Z1 system (Carl Zeiss) with Apotome 
slide module, an AxioCam MRm digital camera, and a 40x (0.5 NA, Plan-Neofluar) objective.  Scale bar = 
10 µm.

Figure 3. Utilizing PLA to detect specific post-translational protein modifications in situ. EGFR is 
stabilized at the plasma membrane in part by the process of neddylation, the addition of Nedd 8 
moieties on the C-terminus. De-neddylation is mediated by a large protein complex, the COPS9 
signalosome, and results in the ubiquitination of EGFR and turnover of the receptor (Najor et al., 2017).  
A. PLA using an antibody pair recognizing EGFRmouse and the Nedd 8 moietyrabbit demonstrate the level of 
the post-translational modification of EGFR in the epithelial cells, visualized by PLA reaction “spots” 
shown red (Duolink™  In Situ Detection Reagent Red, λEx: 594, λEm: 624). Knock down of Nedd8 using 
siRNA technology resulted in the marked decrease in PLA signal. Other negative controls include the 
pairing of each specific antibody with a non-specific IgG counterpart (EGFRmouse:IgGrabbit or 
Nedd8rabbit:IgGmouse). DAPI labels nuclei in blue. B. De-neddylated EGFR (in siCONT panel) results in the 
ubiquitination of the receptor as seen by the strong PLA signal shown in red (Duolink™ In Situ Detection 
Reagent Red, λEx: 594, λEm: 624) when anti-EGFRrabbit is paired with anti-Ubiquitinmouse. As this process is 
regulated by the COPS9 signalosome, loss of an obligate constituent of the complex (siCOPS3 panel) 
results in a decrease in the EGFR ubiquitination, demonstrated by a marked decrease in PLA signal.  
Other controls shown: the pairing of each specific antibody with a non-specific IgG counterpart 
(EGFRrabbit:IgGmouse or Ubqmouse:IgGrabbit). DAPI labels nuclei in blue. Images were acquired using a DMR 
Leica microscope with a 40X (PL Fluotar, NA 1.0) using a Hamamatsu Orca 100 CCD camera, model 
C4742-95. Scale bar = 10 µm.

Figure 4. PLA applied to paraffin-embedded 3D organotypic cultures demonstrating protein-protein 
interactions in situ. Antibodies recognizing Desmoglein 1 (Dsg1goat) and Plakoglobin (Pgmouse), two 
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components of the cell-cell adhesive junction the desmosome, are used to demonstrate the ability to 
visualize proximity between two proteins. For a review on the cell-cell junctions, the desmosome and 
the adherens junction refer to Rübsam et al (Rübsam et al., 2018).  Paraffin-embedded sections of 3D 
organotypic cultures that mimic the epidermal layers of human skin, generated using primary 
keratinocytes isolated from human foreskin were processed for PLA. Refer to Arnette et al. for a 
protocol on growing such cultures (Arnette et al., 2016). A. A strong PLA signal (red) is observed in the 
control section (shCTL), and this specific signal is lost when Dsg1 is silenced (shDsg1) (Duolink™ In Situ 
Detection Reagent Red, λEx: 594, λEm: 624). DAPI labels nuclei in blue. B. In 3D cross sections, using DAPI 
as a measure of cell number is not reliable as not every cell will have a nucleus in the cross section; 
therefore, the sections are quantified and plotted as the average PLA signal area/field. Data points in the 
graph indicate the area of PLA signal per field in a region of the tissue. Error bars indicate the standard 
deviation. ImageJ/FIJI was used for image analysis and data graphed using GraphPad Prism®.  C. 
Immunofluorescence (IF) demonstrates successful binding of both antibodies in the control section, 
while staining is decreased in the Dsg1 knock down condition (Dsg1 or Pg in white, DAPI in blue). Images 
were acquired using an AxioVison Z1 system (Carl Zeiss) with Apotome slide module, an AxioCam MRm 
digital camera, and a 40x (0.5 NA, Plan-Neofluar) objective.  Scale bar = 20 µm.

Figure 5. Use of PLA to compare protein-protein interactions in clinical tissue specimens in situ.  The 
interaction between the desmosomal cadherin Desmoglein 1 (Dsg1goat) and its cytoplasmic partner 
Plakoglobin (Pgmouse) is analyzed in a paraffin-embedded SAM syndrome patient biopsy and compared to 
control tissue. SAM syndrome is a skin disease associated with a loss of Dsg1 expression at the cell-cell 
adhesive interface (Eran Cohen-Barak et al., 2020; Samuelov et al., 2013). A. The PLA signal is clearly 
decreased in the SAM syndrome patient section compared to control tissue (red, Duolink™ In Situ 
Detection Reagent Red, λEx: 594, λEm: 624). B. Traditional immunofluorescence assay performed on 
control tissue is used to demonstrate successful antibody binding to both proteins analyzed by PLA 
(Dsg1, red; Pg, green; DAPI, blue). C. In tissue sections such as this, using DAPI (blue) as a measure of cell 
number is not reliable as every cell will have a nucleus in the cross section; therefore, the PLA signal is 
quantified and plotted as the area of PLA signal per field. Data points in the graph indicate the area of 
PLA signal in a region of the tissue. Error bars indicate the standard deviation. ImageJ/FIJI was used for 
image analysis and data graphed using GraphPad Prism®.  Images were acquired using an AxioVison Z1 
system (Carl Zeiss) with Apotome slide module, an AxioCam MRm digital camera, and a 40x (0.5 NA, 
Plan-Neofluar) objective.  Scale bar = 50 µm.
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Figure 1. Schematic presenting the principal of the Proximity Ligation Assay® (PLA) for the 
detection of two proteins within a proximity of ≤ 40nm. (1) Two antibodies of different species are 
selected that recognize two proteins of interest. (2) Secondary antibodies that recognize the Fc regions of 

the primary antibody species are conjugated with oligonucleotide probes and then incubated with the 
sample. (3) Ligase and free oligonucleotides that hybridize with the probes bring the oligonucleotides 

together in a closed circle confirmation if the proteins are in close enough proximity. (4) Finally, polymerase 
is added to the reaction to allow for rolling circle amplification, while fluorescently labeled oligonucleotides 

hybridize with the rolling circle product resulting in the accumulation of a fluorescent spot in areas of 
successful amplification. 
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Figure 2. PLA applied to cell monolayers demonstrating protein-protein interactions in situ. 
Antibodies recognizing components of the cell-cell adhesive junction, the adherens junction, are used here 
to demonstrate the ability to visualize proximity between two proteins and attribute a spatial signature to 

the interaction within the 2-dimensional cell monolayer.  For a review on the cell-cell junctions, the 
desmosome and the adherens junction refer to Rübsam et al (Rübsam et al., 2018). A. The transmembrane 

protein, E-cadherin (antibody: HECD-1mouse) and its cytoplasmic binding partner β-Catenin (antibody: 
C2206rabbit) demonstrated the use of PLA to reveal protein-protein interactions in situ, visualized by PLA 

reaction “spots” shown in red (Duolink™ In Situ Detection Reagent Red, λEx: 594, λEm: 624).  Plakoglobin 
 (antibody: 1407chicken, white), a constituent of the adherens junction and its related cell-cell junction, the 
desmosome, is used as an immunofluorescent counterstain to reveal the location of cell-cell borders in the 
monolayer to give spatial relevance to the location of the PLA reaction. DAPI labels nuclei in blue.  Controls 
for the assay include combining each primary antibody with pre-immune sera of the opposite species used 

(anti-E-cadherinmouse paired with IgGrabbit (rbIgG) and β-Cateninrabbit paired with IgGmouse (mIgG)). A 
highly recommended control is the silencing of the proteins of interest. Note the decreased PLA signal in the 
siRNA silenced samples in A (siβ-Catenin, siE-Cadherin). B. Traditional immunofluorescence (IF) using the 
antibodies at the same concentrations as used in the PLA reaction is performed to demonstrate successful 
antibody binding and to observe the effect of E-cadherin and  β-Catenin silencing (E-cadherin or β-Catenin, 
white; DAPI, blue). C. Quantification of PLA signal. Data points in the graph indicate the area of PLA signal 

per field/number of cells in the field. DAPI was used to determine cell number. Error bars indicate the 
standard deviation. ImageJ/FIJI was used for image analysis and data graphed using GraphPad Prism®. D. 
Western blot analysis was done in parallel to assess the efficiency of siRNA-mediated knockdown for each 
protein. Note that the knockdown of E-Cadherin resulted in a decrease in β-Catenin levels, reflected in the 

slightly lower amount of PLA signal observed in the siE-Cadherin condition. PLA images were acquired using 
a DMR Leica microscope with a 40X (PL Fluortar, NA 0.7) using a Hamamatsu Orca 100 CCD camera model 
C4742-95. Traditional immunofluorescence images were acquired using an AxioVison Z1 system (Carl Zeiss) 
with Apotome slide module, an AxioCam MRm digital camera, and a 40x (0.5 NA, Plan-Neofluar) objective. 

 Scale bar = 10 µm. 
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Figure 3. Utilizing PLA to detect specific post-translational protein modifications in situ. EGFR is 
stabilized at the plasma membrane in part by the process of neddylation, the addition of Nedd 8 moieties on 
the C-terminus. De-neddylation is mediated by a large protein complex, the COPS9 signalosome, and results 

in the ubiquitination of EGFR and turnover of the receptor (Najor et al., 2017).  A. PLA using an antibody 
pair recognizing EGFRmouse and the Nedd 8 moietyrabbit demonstrate the level of the post-translational 

modification of EGFR in the epithelial cells, visualized by PLA reaction “spots” shown red (Duolink™  In Situ 
Detection Reagent Red, λEx: 594, λEm: 624). Knock down of Nedd8 using siRNA technology resulted in the 
marked decrease in PLA signal. Other negative controls include the pairing of each specific antibody with a 
non-specific IgG counterpart (EGFRmouse:IgGrabbit or Nedd8rabbit:IgGmouse). DAPI labels nuclei in blue. B. 
De-neddylated EGFR (in siCONT panel) results in the ubiquitination of the receptor as seen by the strong 

PLA signal shown in red (Duolink™ In Situ Detection Reagent Red, λEx: 594, λEm: 624) when anti-
EGFRrabbit is paired with anti-Ubiquitinmouse. As this process is regulated by the COPS9 signalosome, loss of 

an obligate constituent of the complex (siCOPS3 panel) results in a decrease in the EGFR ubiquitination, 
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demonstrated by a marked decrease in PLA signal.  Other controls shown: the pairing of each specific 
antibody with a non-specific IgG counterpart (EGFRrabbit:IgGmouse or Ubqmouse:IgGrabbit). DAPI labels nuclei 

in blue. Images were acquired using a DMR Leica microscope with a 40X (PL Fluotar, NA 1.0) using a 
Hamamatsu Orca 100 CCD camera, model C4742-95. Scale bar = 10 µm. 

140x250mm (300 x 300 DPI) 
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Figure 4. PLA applied to paraffin-embedded 3D organotypic cultures demonstrating protein-
protein interactions in situ. Antibodies recognizing Desmoglein 1 (Dsg1goat) and Plakoglobin (Pgmouse), 
two components of the cell-cell adhesive junction the desmosome, are used to demonstrate the ability to 
visualize proximity between two proteins. For a review on the cell-cell junctions, the desmosome and the 

adherens junction refer to Rübsam et al (Rübsam et al., 2018).  Paraffin-embedded sections of 3D 
organotypic cultures that mimic the epidermal layers of human skin, generated using primary keratinocytes 
isolated from human foreskin were processed for PLA. Refer to Arnette et al. for a protocol on growing such 
cultures (Arnette et al., 2016). A. A strong PLA signal (red) is observed in the control section (shCTL), and 
this specific signal is lost when Dsg1 is silenced (shDsg1) (Duolink™ In Situ Detection Reagent Red, λEx: 

594, λEm: 624). DAPI labels nuclei in blue. B. In 3D cross sections, using DAPI as a measure of cell number 
is not reliable as not every cell will have a nucleus in the cross section; therefore, the sections are quantified 
and plotted as the average PLA signal area/field. Data points in the graph indicate the area of PLA signal per 

field in a region of the tissue. Error bars indicate the standard deviation. ImageJ/FIJI was used for image 
analysis and data graphed using GraphPad Prism®.  C. Immunofluorescence (IF) demonstrates successful 

binding of both antibodies in the control section, while staining is decreased in the Dsg1 knock down 
condition (Dsg1 or Pg in white, DAPI in blue). Images were acquired using an AxioVison Z1 system (Carl 
Zeiss) with Apotome slide module, an AxioCam MRm digital camera, and a 40x (0.5 NA, Plan-Neofluar) 

objective.  Scale bar = 20 µm. 

167x158mm (300 x 300 DPI) 
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Figure 5. Use of PLA to compare protein-protein interactions in clinical tissue specimens in situ. 
 The interaction between the desmosomal cadherin Desmoglein 1 (Dsg1goat) and its cytoplasmic partner 
Plakoglobin (Pgmouse) is analyzed in a paraffin-embedded SAM syndrome patient biopsy and compared to 
control tissue. SAM syndrome is a skin disease associated with a loss of Dsg1 expression at the cell-cell 
adhesive interface (Eran Cohen-Barak et al., 2020; Samuelov et al., 2013). A. The PLA signal is clearly 

decreased in the SAM syndrome patient section compared to control tissue (red, Duolink™ In Situ Detection 
Reagent Red, λEx: 594, λEm: 624). B. Traditional immunofluorescence assay performed on control tissue is 
used to demonstrate successful antibody binding to both proteins analyzed by PLA (Dsg1, red; Pg, green; 

DAPI, blue). C. In tissue sections such as this, using DAPI (blue) as a measure of cell number is not reliable 
as not every cell will have a nucleus in the cross section; therefore, the PLA signal is quantified and plotted 
as the area of PLA signal per field. Data points in the graph indicate the area of PLA signal in a region of the 

tissue. Error bars indicate the standard deviation. ImageJ/FIJI was used for image analysis and data 
graphed using GraphPad Prism®.  Images were acquired using an AxioVison Z1 system (Carl Zeiss) with 

Apotome slide module, an AxioCam MRm digital camera, and a 40x (0.5 NA, Plan-Neofluar) objective.  Scale 
bar = 50 µm. 

207x192mm (300 x 300 DPI) 
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